“GIS APPLICATION IN AGRICULTURAL DEVELOPMENT”

User Guide

-Circulated for Comments-

Produced by:
REACTS Project, Kilimo Trust

Funded by:
IFAD

April, 2017
Introduction and Advanced GIS application Agricultural Development

Support from IFAD
Editor Patrick Muganga
Authors Barasa Bernard, Ojambo Emmanuel and Patrick Muganga
Citation GIS application in agricultural development (2017); Training Manual based on QGIS software (version 2.18.3)
Copyright © 2017 Kilimo Trust
Disclaimer

This manual has been developed with the purpose to guide the IFAD project staff and service providers implement GIS technology to solve some of the challenges that hinder their operations in improving agricultural production. The methodological workflows created vary depending to QGIS software version used. The users of this manual therefore, should endeavour to understand the procedures for each version.
**List of acronyms**

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>QGIS</td>
<td>Quantum GIS</td>
</tr>
<tr>
<td>GIS</td>
<td>Geographical Information Systems</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Positioning Systems</td>
</tr>
<tr>
<td>NGO</td>
<td>Non-Governmental Organisations</td>
</tr>
<tr>
<td>CBO</td>
<td>Community based Organisations</td>
</tr>
<tr>
<td>REACTS</td>
<td>Regional East African Community Trade in Staples</td>
</tr>
<tr>
<td>EAC</td>
<td>East African Community</td>
</tr>
<tr>
<td>IFAD</td>
<td>International Fund for Agricultural Development</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Positioning System</td>
</tr>
<tr>
<td>SCP</td>
<td>Semi-Automatic Classification Plugin</td>
</tr>
<tr>
<td>USGS</td>
<td>United States Geological Survey</td>
</tr>
<tr>
<td>TANROADS</td>
<td>Tanzania National Roads Agency</td>
</tr>
<tr>
<td>TMA</td>
<td>Tanzania Meteorological Agency</td>
</tr>
<tr>
<td>TBS</td>
<td>Tanzania Bureau of Standards</td>
</tr>
</tbody>
</table>
Table of Contents

Disclaimer...................................................................................................................................................... 2
List of acronyms ............................................................................................................................................ 3
Table of Contents .......................................................................................................................................... 4
1.1 Introduction............................................................................................................................................ 5
Module One .................................................................................................................................................. 8
2.1 Introduction to Geographical Information System ................................................................................ 8
2.2 What is GIS?........................................................................................................................................... 9
Module Two ................................................................................................................................................ 23
3.1 Types of GIS software........................................................................................................................... 23
3.2 Introduction to QGIS software ............................................................................................................. 24
3.3 Introduction to QGIS ............................................................................................................................ 25
Module Three.............................................................................................................................................. 64
4.1 GIS thematic data sources (Online and offline).................................................................................... 64
4.2 Source of GIS Data.............................................................................................................................. 65
Module Four................................................................................................................................................ 75
5.1 Application of multi-criteria decision making in agricultural land use planning .................................. 75
Module Five ................................................................................................................................................ 81
6.1 How to use multi-temporal Landsat satellite images to monitor agricultural land use and performance changes over time........................................................................................................... 81
   Agricultural............................................................................................................................................... 84
   Forest mapping........................................................................................................................................ 87
   Land cover............................................................................................................................................. 88
Module Six ................................................................................................................................................ 104
6.1 Prediction of risks faced by the farmers using GIS............................................................................. 104
References ................................................................................................................................................ 111
1.1 Introduction

1.2 Background
Kilimo Trust is implementing a grant project from IFAD titled “Regional East African Community Trade in Staples (REACTS)”. REACTS is working with the IFAD-financed agricultural development projects, in the EAC region, to accelerate incomes and wealth creation by smallholder (women, men and youth) producers of food commodities.

REACTS’ mandate is to enable agricultural development projects in the EAC Region to align, build core skills, and work with relevant partners in enabling business enterprises of smallholder producers to respond effectively to regional markets for food products, in the East African Community (EAC), which, as you know, is a common market of over 160 million consumers. REACTS’ Strategy is centered on establishing capabilities and tools for the Projects to support cross-countries business linkages to tap into this market, rather than working directly with the beneficiaries.

REACTS therefore supports the Projects to (1) attain a robust understanding of regional cross-border market opportunities, and then to use such understanding to build business oriented smallholder producers’ enterprises to improve competitiveness in the national and regional markets, (2) build robust structured business linkages that effectively integrate smallholders to profitable regional markets, while building on successes of access to national markets and (3) lastly build new partnerships with traditional and non-traditional service providers; public institutions and private sector players e.g. Ministries of Trade and commercial providers of trade services to support cross-border market linkages and structured trade of food commodities/products.

One of the key tools found to be instrumental in agricultural development is the Geographical Information System (GIS). GIS has demonstrated to be a powerful tool in agricultural decision making for better targeting and integration of agricultural supply and demand markets, ultimately leading to increased farmer incomes. To enhance decision making and better targeting for IFAD funded projects, capacity building in incorporation of GIS in their operation is key. This manual therefore is reference training guide to facilitate capacity of projects to incorporate and utilise of GIS in their operations.
1.3 Objectives
The objectives of this manual are to:
   a) Introduce the participants to introductory GIS technological in agricultural systems
   b) Equip the participants with advanced GIS knowledge and skills to develop, utilise, manipulate and interpret GIS maps

1.4 Target audience
The manual is designed to aid IFAD project staff and service providers, get acquainted with spatial analytical skills to help them increase agricultural productivity & production at smallholder level, access markets and ease monitoring and evaluation of project activities. The manual is not limited to project officers, but also other practitioners in agricultural development such as NGOs, private sector, government institutions and CBOs among others.

1.5 Requirements
The participants are required to have proficient computer knowledge and application skills including but not limited to the use of Microsoft Office packages such as Ms-Word, Ms PowerPoint, and Ms Excel. Those equipped with internet browsing skills, will be an added advantage.

1.6 Time and award
The training is designed to take a total of 5 man-days starting from 8:30am and end at 5:00pm EAT daily. The introductory GIS is scheduled for 2 days whereas advanced GIS 3 days.

1.7 Training modules
Table 1: Training modules

<table>
<thead>
<tr>
<th>No</th>
<th>Modules</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Introductory GIS</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Introduction to Geographical Information Systems</td>
<td>Lecture</td>
</tr>
<tr>
<td>2</td>
<td>Introduction to QGIS software</td>
<td>Lecture &amp; Software application</td>
</tr>
<tr>
<td>3</td>
<td>GIS thematic data sources (Online and offline)</td>
<td>Lecture &amp; Software /Online application</td>
</tr>
<tr>
<td>B</td>
<td>Advanced GIS</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Application of multi-criteria decision making in agricultural land use planning</td>
<td>Lecture &amp; Software application</td>
</tr>
<tr>
<td>5</td>
<td>How to use multi-temporal Landsat satellite images to monitor agricultural land use and performance changes over time</td>
<td>Lecture &amp; Software application</td>
</tr>
<tr>
<td>6</td>
<td>Prediction of risks faced by the farmers using GIS</td>
<td>Lecture &amp; Software application</td>
</tr>
</tbody>
</table>
1.8 Methods of training
The training will be conducted using lectures, group discussions, presentations and exercises. Field work activities aimed at collecting spatial datasets for practical use will be employed. The modes of delivery will comprehensively assist the participants to understand the concepts, fundamentals and software applications of GIS in the agricultural sector.

1.9 Materials to used
An Open Source software here referred to as “QGIS” will be download and used throughout the introductory and advanced training sessions. The participants will be provided with hand-outs, manual, GPS units and videos to guide them complete the given tasks during the training sessions. However, the participants are encouraged to bring functional laptops with them that have moderate specifications such 1gb of ram, 3GB of hard drive and above.

1.10 More readings
The participants are advised to access reading materials online and offline for example from YouTube and Open Source Geospatial Foundation
Module One

2.1 Introduction to Geographical Information System

Introduction
This module is designed to familiarise the participants with an introduction to GIS, data types, coordinate reference systems, spatial analysis, and map production. At the end of this module, the participants are expected to know the following:

1) Definition and applications of GIS in the agricultural sector
2) Data types used in GIS
3) Spatial analysis and associated tools
4) Map production

Training strategy
The module will be facilitated through the use of hand-outs, videos, PowerPoint presentations, etc.

Further reading materials
Handbook on geographic information systems and digital mapping (2002) Series F No. 79
2.2 What is GIS?

2.2.1 Definition
Geographic Information System (GIS) is a computerized tool for capture, storage, retrieval, manipulation, analysis and display of spatial referenced data. With GIS application you can collect spatial data, enter it into a GIS system, store for future use and carryout spatial analysis to create maps/graphs/tables that can aid spatial decision with the aim to improve agricultural development.

2.2.2 Development of GIS
GIS is a relatively new field - it started in the 1970’s. Computerised GIS were only available to companies and universities that had expensive computer equipment. These days, anyone with a personal computer or laptop can use GIS software. Over time GIS Applications have also become easier to use - it used to require a lot of training to use a GIS Application, but now it is much easier to get started in GIS even for amateurs and casual users.

The developments in the field of computer technology have given new direction to handling and using spatial data for assessment, planning and monitoring. The concept of using the computers for making maps and analysing them was initiated with the SYMAP –Synagraphic mapping system, developed by Harvard School of computer graphics in the early 1970. Since then, there has been wide range of automated methods for handling maps using computers.

The history of using computers for mapping and spatial analysis shows that there have been parallel developments in automated data capture, data analysis and presentation in several broadly related fields. All these efforts have been oriented towards the same sort of operation: namely to develop powerful tools for collecting, storing, retrieving at will, transforming, integrating and displaying spatial and non-spatial data from the real world for a particular set of purpose.
The GIS can be used to solve broad range of problems as comparable to any isolated system for spatial and non-spatial data alone. For examples using a GIS:

- Users can interrogate geographical features displayed on computer map and retrieve associated attribute information for display
- Maps can be constructed by querying or analysing attribute data
- New sets of information can be generated by performing spatial operations
- Different items of attribute data can be associated with one another through a shared location codes

2.2.3 Applications

The applications of GIS have increased over years especially with changes in technology. Therefore the use of the tool, and it can do are beyond our imagination.

**General application of GIS**

GIS technologies have been applied to diverse fields to assist experts and professionals in analyzing various types of geospatial data and dealing with complex situations. No matter in business, education, natural resources, tourism, or transportations, GIS plays an essential role to help people collect, analyze the related spatial data and display data in different formats.

The following stories are the successful cases that benefit from applying SuperGIS series products as their solutions in various fields.
GIS in the agricultural development

Some of the notable applications of GIS in the agricultural development are indicated here below but not limited to:

- Offering a huge potential for the scientists to use in the planning of crop management through effective collection of data on soil type, plant phenology and topography that is vital for maximizing crop yields.
- Soil quality in our crop fields is not universal, therefore with the help of GIS, you should be able to interpolate soil values for the non-sampled areas using the collected and analysed figures.
- Mapping is used to find archaeological features in our agricultural land and this has for many years been a successful tool in the heritage industry. However, the same types of data will be useful for agricultural science as underlying features can affect the quality and relative height of the crop produced. The same is true of underlying bedrock.
- GIS is essential in mapping production areas, protected areas, value chain actors such as farmers, infrastructure such as roads, storage facilities and location of farmers, which are vulnerable to natural disasters such as drought and flood. This information is vital in disaster planning and recovery to reduce the farmer’s vulnerability to the devastating eventualities.
- GIS can be used to determine agro-ecologically suitable areas for production of particular crops.
- It is useful in project monitoring and evaluation.

2.2.4 Data types used in GIS

Broadly, a GIS system use twofold categories of datasets: Spatial data and non-spatial data.

a) Spatial data. These are datasets (vector and raster) that have been prepared through field surveys or remote sensed data that is referenced on the earth's surface. The composition of these datasets include satellite images, coordinates among others that are interpreted to produce thematic maps which can aid agricultural planning towards the sustainable use of limited resources.

b) The non-spatial data are attributes as complimentary to the spatial data and describe what is at a point, along a line or in a polygon and as socio-economic characteristics from other sources. The attributes of a soil category could be the depth of soil, texture, erosion, drainage etc.
2.2.5 Spatial data structures

1) Vector model
It represents the geographical feature by a set of coordinates vectors as X, Y-coordinates define points, line and polygons.

The types spatial data in GIS is generally described by X, Y coordinates and descriptive data are best organised in alphanumeric fields. The categories include:

a) Points refer to a single place and usually considered as having no dimension or having dimension which is negligible when compared to the study for example the location of farmers and storage facilities etc.

b) Line represents the linear feature and consists of series of X,Y coordinate pairs with discrete beginning and ending point for example rivers and road network.

c) Polygons are closed features defined by a set of linked lines enclosing an area. The polygons are character by area and perimeter for example the land use, the size of the farmer’s cropped fields.

2) Raster model
It represents the image with help of square grids. The system stores an image by assigning a series of values to each cell identified by its Cartesian coordinates in space.

Raster graphics are digital images created or captured (for example, by scanning in a photo) as a set of samples of a given space. A raster is a grid of x and y coordinates on a display space. A raster image file identifies which of these coordinates to illuminate in monochrome or color values. The raster file is sometimes referred to as a bitmap because it contains information that is directly mapped to the display grid.

2.2.6 Coordinate Reference System
A coordinate reference system (CRS) then defines, with the help of coordinates, how the two-dimensional, projected map in your GIS is related to real places on the earth. The decision as to which map projection and coordinate reference system to use, depends on the regional extent of the area you want to work in, on the analysis you want to do and the availability of data.

2.2.7 Map Projection in detail
A map projection is one of many methods used to represent the 3-dimensional surface of the earth or other round body on a 2-dimensional plane in cartography (mapmaking). This process
is typically, but not necessarily, a mathematical procedure (some methods are graphically based).

A map projection is a system in which locations on the curved surface of the earth are displayed on a flat sheet or surface according to some set of rules.

**Relevance to GIS**

1) maps are a common source of input data for a GIS
   - often input maps will be in different projections, requiring transformation of one or all maps to make coordinates compatible
   - thus, mathematical functions of projections are needed in a GIS
2) often GIS are used for projects of global or regional scales so consideration of the effect of the earth's curvature is necessary
3) monitor screens are analogous to a flat sheet of paper
   - thus, need to provide transformations from the curved surface to the plane for displaying data

**Distortion Properties**

1) angles, areas, directions, shapes and distances become distorted when transformed from a curved surface to a plane
2) all these properties cannot be kept undistorted in a single projection
   a. usually the distortion in one property will be kept to a minimum while other properties become very distorted

**Figure of the Earth**

- a figure of the earth is a geometrical model used to generate projections; a compromise between the desire for mathematical simplicity and the need for accurate approximation of the earth's shape
- types in common use

1. Plane

   - assume the earth is flat (use no projection)
   - used for maps only intended to depict general relationships or for maps of small areas
     - at scales larger than 1:10,000 planar representation has little effect on accuracy
   - planar projections are usually assumed when working with air photos

2. Sphere
• assume the earth is perfectly spherical
  - does not truly represent the earth's shape

3. Spheroid or ellipsoid of rotation

Reference: Ellipsoid of rotation (Maling 1973, p. 2)

• this is the figure created by rotating an ellipse about its minor axis
• the spheroid models the fact that the earth's diameter at the equator is greater than the distance between poles, by about 0.3%
• at global scales, the difference between the sphere and spheroid are small, about equal to the topographic variation on the earth's surface
  - with a line width of 0.5 mm the earth would have to be drawn with a radius of 15 cm before the two models would deviate
  - the difference is unlikely to affect mapping of the globe at scales smaller than 1:10,000,000

Accuracy of figures used

• the spheroid is still an approximation to the actual shape
  - the earth is actually slightly pear shaped, slightly larger in the southern hemisphere, and has other smaller bulges
  - therefore, different spheroids are used in different regions, each chosen to fit the observed datum of each region
  - accurate conversion between latitude and longitude and projected coordinates requires knowledge of the specific figures of the earth that have been used
• the actual shape of the earth can now be determined quite accurately by observing satellite orbits
• satellite systems, such as GPS, can determine latitude and longitude at any point on the earth's surface to accuracies of fractions of a second
  - thus, it is now possible to observe otherwise unapparent errors introduced by the use of an approximate figure for map projections

Creation of a Map Projection

The creation of a map projection involves three steps in which information is lost in each step:

- selection of a model for the shape of the earth or round body (choosing between a sphere or ellipsoid)
- transform geographic coordinates (longitude and latitude) to plane coordinates (eastings and northings).
reduce the scale (in manual cartography this step came second, in digital cartography it comes last)

**Metric properties of maps**
Maps assume that the viewer has an orthogonal view of the map (they are looking straight down on every point). This is also called a perpendicular view or normal view. The metric properties of a map are
1) area
2) shape
3) direction
4) distance
5) scale

**Choosing a projection surface**
If a surface can be transformed onto another surface without stretching, tearing, or shrinking, then the surface is said to be an applicable surface. The sphere or ellipsoid are not applicable with a plane surface so any projection that attempts to project them on a flat sheet will have to distort the image (similar to the impossibility of making a flat sheet from an orange peel). A surface that can be unfolded or unrolled into a flat plane or sheet without stretching, tearing or shrinking is called a ‘developable surface’. The cylinder, cone and of course the plane are all developable surfaces since they can be unfolded into a flat sheet without distorting the projected image (although the original projection of the earth’s surface on the cylinder or cone would be distorted).

**The three families of map projections**
The process of creating map projections can be visualised by positioning a light source inside a transparent globe on which opaque earth features are placed. Then project the feature outlines onto a two-dimensional flat piece of paper. Different ways of projecting can be produced by surrounding the globe in a cylindrical fashion, as a cone, or even as a flat surface. Each of these methods produces what is called a map projection family. Therefore, there is a family of planar projections, a family of cylindrical projections, and another called conical projections.
Introduction and Advanced GIS application Agricultural Development

Figure shows classification of map projection

Geometric Analog

Developable surfaces

- the most common methods of projection can be conceptually described by imagining the developable surface, which is a surface that can be made flat by cutting it along certain lines and unfolding or unrolling it
- the points or lines where a developable surface touches the globe in projecting from the globe are called standard points and lines, or points and lines of zero distortion. At these points and lines, the scale is constant and equal to that of the globe, no linear distortion is present
- if the developable surface touches the globe, the projection is called tangent
- if the surface cuts into the globe, it is called secant
  - where the surface and the globe intersect, there is no distortion
  - where the surface is outside the globe, objects appear bigger than in reality - scales are greater than 1
  - where the surface is inside the globe, objects appear smaller than in reality and scales are less than 1
- note: symbols used in the following: l - longitude j - latitude c - colatitude (90 - lat)
  h - distortion introduced along lines of longitude k - distortion introduced along lines of latitude

(h and k are the lengths of the minor and major axes of the Indicatrix)

commonly used developable surfaces are:

Three families of map projection

a) Cylindrical projection
b) Conical projection
c) Planar projection
1. Planar or azimuthal

- a flat sheet is placed in contact with a globe, and points are projected from the globe to the sheet
- mathematically, the projection is easily expressed as mappings from latitude and longitude to polar coordinates with the origin located at the point of contact with the paper
  - formulas for stereographic projection (conformal) are:
    \[ r = 2 \tan\left(\frac{c}{2}\right) \]
    \[ q = 1 \]
    \[ h = k = \sec^2\left(\frac{c}{2}\right) \]
  - stereographic projection
  - gnomonic projection
  - Lambert's azimuthal equal-area projection
  - orthographic projection

2. Conic

- the transformation is made to the surface of a cone tangent at a small circle (tangent case) or intersecting at two small circles (secant case) on a globe
- mathematically, this projection is also expressed as mappings from latitude and longitude to polar coordinates, but with the origin located at the apex of the cone
  - formulas for equidistant conical projection with one standard parallel \((\phi_0, \text{colatitude } c_0)\) are:
    \[ r = \tan(c_0) + \tan(c - c_0) \]
    \[ q = n \cos(c) \]
    \[ n = \cos(c_0) \]
    \[ h = 1.0 \]
    \[ k = n \frac{r}{\sin(c)} \]
- Examples
3. Cylindrical

- developed by transforming the spherical surface to a tangent or secant cylinder
- mathematically, a cylinder wrapped around the equator is expressed with $x$ equal to longitude, and the $y$ coordinates some function of latitude
  - formulas for cylindrical equal area projection are:

  $$x = l$$
  $$y = \sin(j)$$
  $$k = \sec(j)$$
  $$h = \cos(j)$$

- Examples
  1. note: Mercator Projection characteristics
     - meridians and parallels intersect at right angles
     - straight lines are lines of constant bearing - projection is useful for navigation
     - great circles appear as curves

4. Non-Geometric (Mathematical) projections

- some projections cannot be expressed geometrically
  - have only mathematical descriptions

Examples

- Molleweide
- Eckert

**Universal Transverse Mercator (Utm)**

- UTM is the first of two projection based coordinate systems to be examined in this unit
- UTM provides georeferencing at high levels of precision for the entire globe
• established in 1936 by the International Union of Geodesy and Geophysics
  o adopted by the US Army in 1947
  o adopted by many national and international mapping agencies, including NATO
• is commonly used in topographic and thematic mapping, for referencing satellite imagery
  and as a basis for widely distributed spatial databases

Transverse Mercator Projection

• results from wrapping the cylinder around the poles rather than around the equator
• the central meridian is the meridian where the cylinder touches the sphere
  o theoretically, the central meridian is the line of zero distortion
  o by rotating the cylinder around the poles
  o the central meridian (and area of least distortion) can be moved around the earth
• for North American data, the projection uses a spheroid of approximate dimensions:
  o 6378 km in the equatorial plane
  o 6356 km in the polar plane

Zone System

• in order to reduce distortion the globe is divided into 60 zones, 6 degrees of longitude wide
  o zones are numbered eastward, 1 to 60, beginning at 180 degrees (W long)
• the system is only used from 84 degrees N to 80 degrees south as distortion at the poles is too great with this projection
  o at the poles, a Universal Polar Stereographic projection (UPS) is used
• each zone is divided further into strips of 8 degrees latitude
  o beginning at 80 degrees S, are assigned letters C through X, O and I are omitted

Distortion

• to reduce the distortion across the area covered by each zone, scale along the central meridian is reduced to 0.9996
  o this produces two parallel lines of zero distortion approximately 180 km away from the central meridian
  o scale at the zone boundary is approximately 1.0003 at US latitudes

Coordinates

• coordinates are expressed in meters
eastings (x) are displacements eastward
northings (y) express displacement northward

- the central meridian is given an easting of 500,000 m
- the northing for the equator varies depending on hemisphere
  - when calculating coordinates for locations in the northern hemisphere, the equator has a northing of 0 m
  - in the southern hemisphere, the equator has a northing of 10,000,000 m

Advantages

- UTM is frequently used
- consistent for the globe
- is a universal approach to accurate georeferencing

Disadvantages

- full georeference requires the zone number, easting and northing (unless the area of the data base falls completely within a zone)
- rectangular grid superimposed on zones defined by meridians causes axes on adjacent zones to be skewed with respect to each other
  - problems arise in working across zone boundaries
  - no simple mathematical relationship exists between coordinates of one zone and an adjacent zone

2.2.8 Spatial analysis

Spatial analysis is the process of manipulating spatial information to extract new information and meaning from the original data. Usually spatial analysis is carried out with a Geographic Information System (GIS). A GIS usually provides manipulation and spatial analysis tools for calculating feature statistics and carrying out geoprocessing activities as data interpolation. For example, the tool will facilitate the computation of an area of land under cultivation, proximity of farmed land to the sensitive ecosystems and update layers etc

Some of the tools used for spatial analysis include:

- Buffering. A buffer zone is any area that serves the purpose of keeping real world features distant from one another
- Clip: Refers to extraction of specific features from the input layer
- Merge: Refers to the combination of distant features
**2.2.9 Map production**

Map production is the process of arranging map elements on a sheet of paper in a way that, even without many words, the average person can understand what it is all about. Maps are usually produced for presentations and reports where the audience or reader is a politician, citizen or a learner with no professional background in GIS. Because of this, a map has to be effective in communicating spatial information. Common elements of a map are the title, map body, legend, north arrow, scale bar, acknowledgement, and map border.

![Map of Tanzania created after overlay of GIS layers](image)

---

**2.2.10 GIS Workflow (Process)**

![GIS Process diagram](image)

Does the decision solve the problem? If not, then refine the problem and start the process again.
Module Two

3.1 Types of GIS software

A Geographic Information System (GIS) Software is designed to store, retrieve, manage, manipulate, display, and analyze all types of geographic and spatial data.

GIS software enables you produce maps and other graphic displays of geographic information for analysis and presentation.

We have two types of GIS software: Open source and commercial software

Open source software
The development of open source GIS software has—in terms of software history—a long tradition with the appearance of a first system in 1978. Numerous systems are available which cover all sectors of geospatial data handling. Eg QGIS, SAGA GIS, uDIG, JUMP GIS etc

Most open source software is available for free and the users can benefit from the availability and transparency of the open source (program) code, which may be adapted for specific consumer needs and can again be shared within the community.

Commercial software
These are softwares that are purchased prior to usage in carrying out spatial analysis. Some of the notable software include: ArcGIS, ENVI, Erdas Imagine, ESRI, Intergraph etc

It is important to the NOTE that this manual has been created based on open source software (QGIS) version 2.18.3

The software is free and available and has capabilities of handling spatial data analysis and publication.

Reference
3.2 Introduction to QGIS software

Introduction
The previous module has just illustrated a broader introduction to GIS and its application. The subsequent modules demonstrate the practical application of GIS.

In particular, this module is designed to familiarise the participants with an introduction to the QGIS software interface, its utilities, data display, analysis and map production.

At the end of this module, the participants are expected to know the following:
1. Add and manipulate layers within QGIS
2. Change layer properties
3. Identify the geo-processing tools and carryout spatial analysis
4. Produce map layouts ready for map publication

Training strategy
The module will be facilitated through the use hand-outs, videos, PowerPoint presentations etc

Further reading materials
QGIS User Guide (2014), Release 2.2
3.3 Introduction to QGIS

3.3.1 Background
QGIS is an Open Source Geographic Information System. The project was born in May 2002 and was established as a project on SourceForge in June of the same year. QGIS currently runs on most Unix platforms, Windows, and OS X. QGIS is developed using the Qt toolkit (http://qt.digia.com) and C++. This means that QGIS feels snappy and has a pleasing, easy-to-use graphical user interface (GUI).

QGIS aims to be a user-friendly GIS, providing common functions and features. The initial goal of the project was to provide a GIS data viewer. QGIS has reached the point in its evolution where it is being used by many for their daily GIS data-viewing needs. QGIS supports a number of raster and vector data formats, with new format support easily added using the plugin architecture. QGIS is released under the GNU General Public License (GPL). Developing QGIS under this license means that you can inspect and modify the source code, and guarantees that you, our happy user, will always have access to a GIS program that is free of cost and can be freely modified.

3.3.2 Data preparation
The datasets that have been prepared to conduct the training are freely downloadable on the internet. However, efforts have made to prepare the datasets so that they display easily and faster for example extracting the areas of interest and harmonising the projection parameters. The datasets are stored in the training folder for accessibility purpose.

You may use this dataset without difficulty, but you may prefer to use data from your own field data. If you choose to do so, your localised data will be used in all the sessions.

3.3.3 Software installation
We recommend that you use the most recent version of QGIS available online. Either the 32 bit or 64 bit versions should work.

3.3.4 For Windows users
Download and run the standalone installer, available here:
   a)  http://download.qgis.org.
   b) Select and download the version that is suitable for your workstation
   c) After downloading, double click the setup to run the installation files
3.3.5 Other computer operating platforms
Access the software depending on your operating systems as shown below

<table>
<thead>
<tr>
<th>Platform</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download for Mac OS X</td>
<td></td>
</tr>
<tr>
<td>Download for Linux</td>
<td></td>
</tr>
<tr>
<td>Download for BSD</td>
<td></td>
</tr>
<tr>
<td>Download for Android</td>
<td></td>
</tr>
</tbody>
</table>

3.4 Exploring the QGIS interface
Steps
a) Launch QGIS desktop from your computer desktop or look under the start menu → all programmes → QGIS wien → QGIS desktop
b) Configure/activate plugin by going to the plugin menu → click manage and install plugins. Click on the **installed plugins** button in the menu on the left. Keep the following plugins checked: DB manager, fTools, GdalTools and processing
c) Configure the toolbars → right click on the blank area of the toolbar view menu. Make sure that the following features are checked: browser, layers, attributes, digitizing, file, help, label, manage layers and map navigation. Every time you check or uncheck a feature the toolbar view menu will disappear so you will need to right click on a blank area of the toolbar to get it back
d) Move toolbars. Move the toolbars around by hovering over the left edge of a toolbar until you see a crosshairs, left click and hold, then drag and drop
e) Un-stack the browser and map legend to keep the interface less cluttered
3.5 Adding vector data

Steps

a) Examine your data. Minimise QGIS for a moment and take a look at the data files stored in the training folder.

b) To add the stored shapefiles. Go onto the tool bar, click the add vector layer button. When the add vector layer box appears, hit the browser button.

c) Browse through the folder list to the data folder. In the files of type dropdown at the bottom of the window make sure the ESRI shapefiles option is selected.

d) Select the first layer in the list, hold down the shift key, then select the remaining layers.

“A shapefile is a very common file format used for storing vector GIS data. It was created by ESRI, the company that produces ArcGIS (the predominant software in the proprietary GIS market).

Shapefiles are an open GIS format” that can be used in just about any GIS software package, including QGIS.
e) Changing the layer drawing order. Click on the first layer that’s listed in the **layers panel**, hold down the left mouse button, and drag it to the bottom of the list. This moves that layer from the top of the drawing order to the bottom. The layers in the layers panel are stacked on top of each other and their order in the list determines which are visible relative to others.

f) Change the colours of the added layers. Double click each of the added vector layers (**district boundary**) in the **layers panel** to open the **layer properties** menu for that layer. Click on the **Style** tab. Click the drop down menu beside the colour box. Change the colours by choosing from the palette of standard colours. Click **OK** on the style menu to make the change and close the window.

![Image showing how to change layer colors](image)

Figure shows how to change the colours of the added layers

### 3.6 Exploring the map view

### 3.7 Exploring features

**Steps**

a) Identify the features. Click **identify features** button in the toolbar. Click in one of the polygons on **district boundary** layer. The selected polygon is highlighted and information about that feature is displayed.
b) Open the attribute table. Right click one of the layer in the layers panel and select open attribute table (alternatively, you could click the open attribute table button on the toolbar). Explore the table by scrolling across it and down.

c) Select a feature from the table. Sort the table by clicking on the field (column) heading that contains the field title. You can select multiple records from the table by holding down the CTRL key and selecting records one by one.

**Attribute table**
Every vector feature has a record in the attribute table; you can’t have a feature without an attribute or vice versa. In a shapefile, the geometry is stored in the .shp file, an index of the geometry is in the .shx file, and the attributes are stored in a .dbf file.

d) Select a feature from the map. Using the **district boundary** layer still selected in the layers panel, hit the select feature button in the toolbar. Select any district of your choice.

**Deselect the layers by clicking on**

e) Select features by attribute. Close the attribute table for the District boundary layer. Hit the select features using an expression button on the toolbar. The button opens the select by expression window, which allows you to select features based on shared attributes. In the functions list, scroll down to fields and values and hit the plus symbol to expand the options. Note the expression window is also available in the attribute table window via the same button.
f) Labeling features. Attributes stored in the table can also be used to label features. The District boundary layer in the layers panel to activate it. Click the layer labeling option on the toolbar (alternatively, you can double click on the layer in the layers panel and access the label tab via the layer properties menu). Select show labels for this layer option and also select the label with...in the drop down menu to hit the district name field (NAME_1)
3.8 Adding raster layer

Steps

a) Add raster data. Hit the add raster layer button on the toolbar, browse to the data folder and select the Elevation.tif file and hit open

b) Explore the raster data. Select the elevation layer in the layers panel. Right click on the layer and select zoom to best scale (100%). Double click to open the layer properties and go to the Transparency tab. Drag the Global transparency slider to 34% and click OK

c) View raster properties. Double click on the raster layer in the layers panel to open its properties. Select the style tab. Each class represents the colour of pixels on the map. Render type: singleband pseudocolour, band: band1 (Gray), Colour: PiYG, Mode: Equal Interval, Classes 9, Click on Apply, Click on OK
d) Extract raster features. Unlike vector features, rasters have no attributes as the layer exists as a grid of pixels, and not as discrete entities. You can extract raster features based on their pixel values, assuming that the values have some meaning (i.e. the pixel value represents elevation, terrain, temperature, etc.)

e) Select the Raster menu in the Menu Bar, and select the Raster Calculator (if the Raster menu is not visible, make sure that the gdal plugin has been activated under the plugins menu).

f) Select areas in height above 1766 ("Elevation@1" >= 1766)

Examine the raster output. Examine the added output. This example simply demonstrates how rasters differ from vectors, and how you can work with them to extract features.

g) Saving your project: from the project menu □ save as □ save the file in the training folder
3.9 Geo-processing shapefiles
This section introduces you on how to process a shapefile ready for analysis. This is a common task if you want to extract information from the spatial layer. The aim of processing is to make the data usable. Geoprocessing is essentially a GIS operation used to manipulate the spatial aspects of GIS data. In the broad sense the tools include: overlay, clipping, update, feature selection, union, and dissolve among others.

3.10 Geo-processing tools
- Convex Hulls - creates the smallest possible convex polygon enclosing a group of objects
  \[\text{Vector} \rightarrow \text{Geoprocessing Tools} \rightarrow \text{convex hull(s)}.\]

- Buffers - creates an equal zone around specific features at a specified distance
  \[\text{Vector} \rightarrow \text{Geoprocessing Tools} \rightarrow \text{Variable Distance Buffer}.\]

- Intersect - creates new layer based on the area of overlap of two layers
  \[\text{Vector} \rightarrow \text{Geoprocessing Tools} \rightarrow \text{Intersect}.\]
• Union - melds two layers together into one while preserving features and attributes of both
  Vector > Geoprocessing Tools > Union.

• Symmetrical Difference - creates new layer based on areas of two layers that do not overlap
  Vector > Geoprocessing Tools > Symmetrical Difference

• Clip - cuts a layer based on the boundaries of another layer
  Vector > Geoprocessing Tools > Clip

• Difference - subtracts areas of one layer based on the overlap of another layer
  Vector > Geoprocessing Tools > Difference

• Dissolve - merges features within a single layer based on common attributes in the attribute table
  Vector > Geoprocessing Tools > Dissolve

• Eliminate Sliver Polygons - merges left-over or misformed geometry with neighboring feature

In addition, there are also some geoprocessing tools under the Geometry Tools menu in ftools that convert or break polygons apart into simpler features (like lines or points) and under the Data Management Tools menu (for aggregating many shapefiles into one file; the opposite of the selection / subset process). Geoprocessing for raster layers is available through the GDAL plugin (Raster menu). Lastly, several extensive collections of processing tools for both vectors and rasters are available in the Toolbox under the Processing menu.
3.11 Joining and mapping spatial data

In this section, you will learn how to join an attribute table with an Ms Excel populated file with the characteristics of farmer information such as areas cultivated under maize etc. In this exercise, you are required to populate the district boundary layer attribute table with an excel file named ‘joining tables’ and create a map based on the added information.

Steps

a) Open the District_boundary layer feature in QGIS

![District_boundary layer in QGIS](image)

b) Examine the layer's attribute table. The fourth column contains unique identifiers. We will use the NAME_1 unique identifier for this case which is the fifth column.

<table>
<thead>
<tr>
<th>ID_0</th>
<th>ISO</th>
<th>NAME_0</th>
<th>ID_1</th>
<th>NAME_1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TZA</td>
<td>Tanzania</td>
<td>3052</td>
<td>Arusha</td>
</tr>
<tr>
<td>2</td>
<td>TZA</td>
<td>Tanzania</td>
<td>3053</td>
<td>Dar-Es-Salaam</td>
</tr>
<tr>
<td>3</td>
<td>TZA</td>
<td>Tanzania</td>
<td>3054</td>
<td>Dodoma</td>
</tr>
<tr>
<td>4</td>
<td>TZA</td>
<td>Tanzania</td>
<td>3057</td>
<td>Iringa</td>
</tr>
<tr>
<td>5</td>
<td>TZA</td>
<td>Tanzania</td>
<td>3058</td>
<td>Kilimanjaro-Pemba</td>
</tr>
<tr>
<td>6</td>
<td>TZA</td>
<td>Tanzania</td>
<td>3059</td>
<td>Kigoma</td>
</tr>
<tr>
<td>7</td>
<td>TZA</td>
<td>Tanzania</td>
<td>3060</td>
<td>Mwanza</td>
</tr>
<tr>
<td>8</td>
<td>TZA</td>
<td>Tanzania</td>
<td>3061</td>
<td>Moshi-Runguru</td>
</tr>
</tbody>
</table>

Examine the attribute table of the tracts. Close the Excel file, exit your spreadsheet software and maximize QGIS.
d) Add the excel file to the project. The QGIS browser isn’t configured to display excel files. You will use the add the vector data button. In the change file type drop down from All. Click on joining table to select it, then hit open and open again on the menu to add it

e) Join data table to shapefile. Close the table, and double click on the District_boundary layer to open its properties menu. Hit the Joins tab. Hit the green plus button to add a join. The join layer will be the data table joining tables. The Join field in that table is NAME_1. The Target field in the tract layer is NAME_1. At the bottom of the menu, check the box that says Custom field name prefix, and remove Joining table so that the option is blank.
f) Make the join permanent. The data has been joined to the shapefile but to make it permanent. We simply have this shapefile as a new one. So select District_boundary layer and in the layer panel right click and choose Save As browse to your working folder.

g) Map the data. Now that the data is joined to the boundaries, we can map it. Double click the District_boundary layer and go to the Style tab. Change the Legend type dropdown from Single symbol to Graduated. Change the mode from Equal Interval to Natural Breaks. In the Color ramp drop down select a scheme that has a range of single-color values that go from light to dark. Hit the Classify button, and then hit OK.
Categorised map
3.12 Projecting of layers in QGIS

QGIS automatically reads projection information (i.e. the coordinate reference system [CRS]), if available, from respective layer files. For shapefiles, it relies on the '.prj' file; for raster data, it is often embedded in the file. If you load data without built-in projection information (e.g. a delimited text file), it assumes a geographic coordinate system (Lat/Long), and uses the World Geodetic Survey 1984 (WGS84) datum, or may as the user to specify.

3.12.1 Data preparation

- Load the world layer from your working folder
- Extract (clip) UGANDA from the world layer as shown below

- Save the vector layer as.................
To check the CRS, (and set it if it was not automatically detected) right-click on layer and select “Set Layer CRS”

If you do this for the world layer you will see the CRS that selected is WGS84 (using Lat/Long coordinates). This is correct – the datum of the original data was exactly that, so nothing needs to be changed, although if it was incorrect, you could fix that here. Earlier we set QGIS such that layers with different projections are “Projected on the Fly” – for visualization they are automatically transformed to be in the same coordinate space. Changing that, will make it is easy to tell if individual layers are set to drastically different coordinate systems.

Click the Project Menu at on the menu bar at top and select Project Properties (or use keyboard shortcut, CTRL+SHIFT+P) and select the “CRS” tab. Then, uncheck the box at top for “Enable ‘on the fly’ CRS transformation” and click “OK”. Now you can see how the layers line up to each other when using their native projections – click the “Zoom Full” button on the toolbar at top, and the map area will zoom out to include all layers.

3.12.2 Changing Vector CRS (for a Shapefile or Text-Delimited Layer)

a) This process involves creating a new shapefile with the desired CRS.
b) Right-click on layer that you wish to change the CRS of (in this case, select the Tanzania) and Select “Save As”
c) Set “Format” to “ESRI Shapefile”
d) Use the “Save As” box to designate an appropriate file location and name for the resulting shapefile.
e) For the CRS, you can use the “Project CRS” (Or use the Browse button to navigate to the appropriate CRS if necessary filter 32636 for Uganda).
f) Selecting “Layer CRS” retains the original CRS
g) Check the box for “Add Saved File to Map”

h) Click “OK” (the original layer can then be removed from the map by right clicking on it and selecting “remove”).

3.12.3 Introduction to Global Positioning Systems

The Global Positioning System (GPS) is a satellite-based navigation system made up of a network of 24 satellites placed into orbit by the U.S. Department of Defense. GPS was originally intended for military applications, but in the 1980s, the government made the system available for civilian use. GPS works in any weather conditions, anywhere in the world, 24 hours a day.

3.12.4 How it works

GPS satellites circle the earth twice a day in a very precise orbit and transmit signal information to earth. GPS receivers take this information and use trilateration to calculate the user's exact location. Essentially, the GPS receiver compares the time a signal was transmitted by a satellite with the time it was received. The time difference tells the GPS receiver how far away the satellite is. Now, with distance measurements from a few more satellites, the receiver can determine the user's position and display it on the unit's electronic map.
A GPS receiver must be locked on to the signal of at least 3 satellites to calculate a 2-D position (latitude and longitude) and track movement. With four or more satellites in view, the receiver can determine the user's 3-D position (latitude, longitude and altitude). Once the user's position has been determined, the GPS unit can calculate other information, such as speed, bearing, track, trip distance, distance to destination, sunrise and sunset time and more.

### 3.12.5 How accurate is GPS?

Today's GPS receivers are extremely accurate, thanks to their parallel multi-channel design. Our 12 parallel channel receivers are quick to lock onto satellites when first turned on, and they maintain strong locks, even in dense foliage or urban settings with tall buildings. Certain atmospheric factors and other sources of error can affect the accuracy of GPS receivers. Garmin GPS receivers are accurate to within 15 meters, on average.

Newer Garmin GPS receivers with **WAAS** (Wide Area Augmentation System) capability can improve accuracy to less than 3 meters on average. No additional equipment or fees are required to take advantage of WAAS. Users can also get better accuracy with **Differential GPS (DGPS)**, which corrects GPS signals to within an average of 3 to 5 meters. The U.S. Coast Guard operates the most common DGPS correction service. This system consists of a network of towers that receive GPS signals and transmit a corrected signal by beacon transmitters. In order to get the corrected signal, users must have a differential beacon receiver and beacon antenna in addition to their GPS.

### 3.12.6 The GPS satellite system
The 24 satellites that make up the GPS space segment are orbiting the earth about 12,000 miles above us. They are constantly moving, making two complete orbits in less than 24 hours. These satellites are travelling at speeds of roughly 7,000 miles an hour.

GPS satellites are powered by solar energy. They have backup batteries onboard to keep them running in the event of a solar eclipse, when there's no solar power. Small rocket boosters on each satellite keep them flying in the correct path.

Here are some other interesting facts about the GPS satellites (also called NAVSTAR, the official U.S. Department of Defense name for GPS):

- The first GPS satellite was launched in 1978.
- A full constellation of 24 satellites was achieved in 1994.
- Each satellite is built to last about 10 years. Replacements are constantly being built and launched into orbit.
- A GPS satellite weighs approximately 2,000 pounds and is about 17 feet across with the solar panels extended.
- Transmitter power is only 50 Watts or less.

**3.12.7 What’s the signal?**

GPS satellites transmit two low power radio signals, designated L1 and L2. Civilian GPS uses the L1 frequency of 1575.42 MHz in the UHF band. The signals travel by line of sight, meaning they will pass through clouds, glass and plastic but will not go through most solid objects such as buildings and mountains.

A GPS signal contains 3 different bits of information - a pseudorandom code, ephemeris data and almanac data. The pseudorandom code is simply an I.D. code that identifies which satellite is transmitting information. You can view this number on your Garmin GPS unit's satellite page, as it identifies which satellites it's receiving.

Ephemeris data, which is constantly transmitted by each satellite, contains important information about the status of the satellite (healthy or unhealthy), current date and time. This part of the signal is essential for determining a position.

The almanac data tells the GPS receiver where each GPS satellite should be at any time throughout the day. Each satellite transmits almanac data showing the orbital information for that satellite and for every other satellite in the system.
3.12.8 Some of the GPS applications in the agricultural sector

The application of GPS in agriculture is not limited to; location of beneficiaries, farm size determination, mapping infrastructure, monitoring weeds, pests and disease spread, and crop damage due to drought and hailstorms.

A field map can be created using GPS to record the coordinates of field borders, fence lines, and point locations such as wells, stores, buildings, and landscape features. The resulting field map might be the first layer a producer would develop for an on-farm GIS (Geographic Information System). Additional layers showing crop damage from hail or drought, and riparian areas or wetlands could be mapped using GPS.

3.12.9 Sources of GPS signal errors

Factors that can degrade the GPS signal and thus affect accuracy include the following:

a) Ionosphere and troposphere delays - The satellite signal slows as it passes through the atmosphere. The GPS system uses a built-in model that calculates an average amount of delay to partially correct for this type of error.

b) Signal multipath - This occurs when the GPS signal is reflected off objects such as tall buildings or large rock surfaces before it reaches the receiver. This increases the travel time of the signal, thereby causing errors.

c) Receiver clock errors - A receiver's built-in clock is not as accurate as the atomic clocks on-board the GPS satellites. Therefore, it may have very slight timing errors.

d) Orbital errors - Also known as ephemeris errors, these are inaccuracies of the satellite's reported location.

e) Number of satellites visible - The more satellites a GPS receiver can "see," the better the accuracy. Buildings, terrain, electronic interference, or sometimes even dense foliage can block signal reception, causing position errors or possibly no position reading at all. GPS units typically will not work indoors, underwater or underground.

f) Satellite geometry/shading - This refers to the relative position of the satellites at any given time. Ideal satellite geometry exists when the satellites are located at wide angles...
relative to each other. Poor geometry results when the satellites are located in a line or in a tight grouping.

g) Intentional degradation of the satellite signal - Selective Availability (SA) is an intentional degradation of the signal once imposed by the U.S. Department of Defense. SA was intended to prevent military adversaries from using the highly accurate GPS signals. The government turned off SA in May 2000, which significantly improved the accuracy of civilian GPS receivers.

3.12.10 Setting up GPS

GPS receivers are simple electronic devices and as such the way their set up will affect what data is collected. Before going into the field all staff must know how to use the GPS receiver, what to check for before collecting data, and simple maintenance of the devices. Every GPS receiver will be slightly different, so it is not possible to give exact details in this document. The manual that came with the GPS receiver should be used to find the exact methods to carry out the tasks listed below.

GPS receivers work by receiving signals from satellites that orbit the Earth. When you use the receiver for the first time, it has to find the satellites and update all its information on satellite locations. Most GPS receivers call this “Searching the sky”. This process can take up to 30 minutes, during which the GPS should be left somewhere with a clear view of the sky. Once the process is complete the position will be shown on the screen. This process must be repeated if the receiver is not used for 4 months or if it is moved large distances, i.e. between countries or within very large countries. If you move less than 200km from the previous location then the update will not be required.

3.12.11 Recording GPS coordinates

Waypoint coordinates may be recorded in different ways: Write on paper record in the device and download later, Type into a database, Enter into a storage device. The simplest is to have two columns on a paper form to enter the coordinates. The X coordinate and Y coordinate can simply be written down into the correct columns. It is important to ensure they are written down correctly. Having written down the coordinates it should be double checked to reduce errors.

This method works best if other information is being collected at the same time, e.g. information about a case or structure. If only the coordinates are being collected then it can be stored in the GPS receiver as a waypoint. Most GPS receivers will store up to 250 waypoints at a time. Having got the location the waypoint is created or marked. This stores the coordinates
to be downloaded directly into a computer at a later date. If storing coordinates this way, you still have to keep a written record of what each waypoint represents. Care needs to be taken to ensure these waypoints are downloaded. Check frequently to avoid the memory filling up. By storing the location as waypoints in the GPS device, Google Earth can map the waypoints directly (in Google Earth select Tools / GPS select Garmin – waypoint and click Import).

3.12.12 Maintenance
1) GPs receivers should be regularly checked and maintained. There are two main parts to this:
2) Check batteries. GPS receivers batteries usually only last for between 14 – 16 hours. The simplest way to do this is to turn the receiver on and there is no “Low battery” warning. It is vital that especially when going to remote locations that there are spare batteries.
3) Clean up memory. Receivers store information and this can be confusing. GPS receivers should be regularly cleaned up with all waypoints and tracks removed so that all the memory is available.

3.12.13 Defining protocols for field use
The information that should be defined as part of the field protocols includes:
1) Coordinate system and Map Datum
   The default coordinate system and map datum should be latitude and longitude, and WGS 84. Only on rare occasions should anything else be used
2) Acceptable accuracy for waypoints
   Standard GPS receivers are only guaranteed accurate to 20m however in locations with only 1 storey buildings the accuracy is usually better than 10m. The accuracy required should be defined and waypoints only collected when the accuracy is below that threshold.
3) Position to stand to find location
   a. So a protocol defining the default locations should be tested before starting field work. For village centroids or area centroids, somewhere on the main road / path through the village may be a suitable location.
   b. For a house it may be suitable to stand 1 – 2m in front of the main entrance to the house
4) Checking / maintenance routine
   There should be a protocol for verifying the coordinates collected and for maintenance of the GPS receivers

3.12.14 Setting GPS units
1) Set the units to meters for you to be able to carry out field measurements
2) Set position format to UTM UPS (Universal Transverse Mercator)
3) Datum should be change to WGS1984

3.12.15 Field Area calculation
a) Switch on your GPS units and wait shortly for an improved accuracy
b) Go to the main menu and select Area calculation
You can calculate Area and Display in:
  ➔ Acres
  ➔ Square Miles
  ➔ Square Feet
  ➔ Hectares
  ➔ Square Kilometers
  ➔ Square Meters
c) Press START and you move around the field until you reach the original departure point and then stop the calculator
d) Record the field computations in your Notebook
e) Enter the recorded computations into an excel sheet as an attribute “area”
f) Add the entered excel sheet into QGIS and plot the farmer’s area acreage

3.12.16 Steps
3.12.17 Adding GPS Points in QGIS
a) Enter the GPS coordinates in an excel sheet with columns X, Y and Z for elevation which is at times left out.
b) Save the excel file as “.CSV(comma separated Values)”
c) Go to File > Save As > Other Formats.
d) A new windows is opened, choose the Save As Types as “CSV(Comma Delimited)”
e) In QGIS, go to Layer > Add Layer > Add Delimited Text Layer or Click on the Add Delimited Text Layer button:

![Add Delimited Text Layer](image)
f) Browse to the directory where you saved .CSV file, choose the file and click OK.
g) The layer for GPS points has been added in the Layers Panel.

h) Disable other layers and zoom the GPS coordinates to layer

3.13 GIS data capture and update of vector features

3.13.1 Digitalization
Digitizing in GIS is the process of converting geographic data either from a hardcopy, digital or a scanned image into vector data by tracing the features. During the digitizing process, features from the traced map or image are captured as coordinates in point, line, or polygon form
3.13.2 Types of Digitizing in GIS

There are several types of digitizing methods.

a) Manual digitizing involves tracing geographic features from an external digitizing tablet using a puck (a type of mouse specialized for tracing and capturing geographic features from the tablet).

b) Heads up digitizing (also referred to as on-screen digitizing) is the method of tracing geographic features from another dataset (usually an aerial, satellite image, or scanned image of a map) directly on the computer screen.

c) Automated digitizing involves using image processing software that contains pattern recognition technology to generated vectors.

3.13.3 Application in agriculture

- It is vital in crop field boundaries demarcation
- Updating farmer fields under production
- Capture of storage facilities and household locations
- Estimation of areas under cultivation or not cultivated from satellite images
- Location of markets
- Monitoring and evaluation
- Updating infrastructure like roads, storages, protected areas

3.13.4 Summary visualization of the main types of digitizing errors

Steps ( Digitization in QGIS)

Digitizing is one of the most common tasks that a GIS Specialist has to do. Often a large amount of ‘GIS time’ is spent in digitizing raster data to create vector layers that you use in your analysis.
Quantum GIS has powerful capabilities that allow to digitize raster data. We will use the high resolution Quickbird satellite imagery and digitize it to create vector layers.

Before you start to digitize, first define how the different vector layer entities will be captured from the image e.g.

- Trees, cars - points
- Roads, power lines - lines
- Landuse - polygons

The task is to digitize linear, point and polygon features in the image.

a) Load the satellite image named Dodoma in QGIS by clicking add raster icon.

b) Go the layer menu from the main toolbar and select new new shapefile layer. Let’s start with point type of vector (trees), define the appropriate projection parameters. The field name should be typed as trees, type decimal number and then HIT OK.
c) For lines, please follow the above mentioned procedures for creating new shapefiles.

d) The same for polygons.
e) Before we start, we need to set default Digitizing Options. Go to Settings → Options....

f) Select the Digitizing tab in the Options dialog. Set the Default snap mode to vertex and segment. This will allow you to snap to the nearest vertex or line segment. I also prefer to set the Default snapping tolerance and Search radius for vertex edits in pixels instead of map units. This will ensure that the snapping distance remains constant regardless of zoom level. Depending on your computer screen resolution, you may choose an appropriate value.

g) Click OK.

![Digitizing Options Settings](image)

h) Now enable the ‘Digitizing’ toolbar by right clicking in the ‘Toolbar’ section of QGIS. In the pop up menu, make sure ‘Digitizing’ box is checked.
i) Select the ‘trees’ layer in the layers panel. Zoom to a region where you can see trees in the image. Then click ‘Toggle Editing’

j) Click the icon for editing each specific entity (e.g. trees click on the points, buildings on polygon icon etc)
k) Click on the tree features in the image
l) Upon finishing to digitize the trees, select roads and start to draw the roads BUT
m) Before we digitize roads, it is important to update some other settings that are important to create an error free layer. Go to Settings → Snapping Options
n) In the Snapping Options dialog, check the Enable topological editing. This option will ensure that the common boundaries are maintained correctly in polygon layers. Also check the Enable snapping on intersection which allows you to snap on an intersection of a background layer.

![Screenshot of Snapping Options dialog]

o) Draw the polygons by clicking on the edge of the visible objects (field, buildings, farms etc). Keep clicking till the polygon is complete.
p) Right click to join the last node to the first one and close the polygon. A dialog will pop-up asking for attribute information. Enter the ‘Id’ of the feature you just digitized and click OK.
q) Similarly, draw polygons for other features in the image. You can look at the other options in the toolbar to help you with your editing. Once you are done, click on ‘Toggle Editing’ button. In the pop-up dialog, click on ‘Yes’ to save your edits.
r) The final digitized layers will be appear as below
3.14 Running Statistics and Querying Attributes

In this section, you will learn to calculate basic statistics for attributes and use some of the advanced features. Now that all the datasets are still displayed, we want to select the districts that are cultivated between 400 to 800 hectares under maize.

Application

😊 Using this approach you can calculate how much land is under crop cultivation using different units e.g. hectares, acres, sqkm etc

😊 You can also compute the length of the road

Steps

a) Run some basic statistics. On the menu bar select Vector ▶ Analysis Tools ▶ Basic Statistics for numeric fields. Choose District_boundary as the input vector layer. Change the target field maize_ha. Hit OK.
b) **Statistics**
c) Advanced spatial query

Click the expression button. In the function list scroll down to fields and values, expand the menu and double click on maize_ha to add it to the Expression builder. In the expression box.

d) Save your selection as a new shapefile. Select District_boundary in the layers panel. Right click and choose Save As. Make sure to check the two boxes that say Save only selected features and Add saved file to map.
3.14.1 Changing Raster CRS

a) As with vector datasets, when reprojecting a raster (Elevation), a new file is created and added to the project

b) Click on the Raster menu, mouse along to Projections, and click on “Warp (Reproject)”.

c) Designate the input file from the current project

d) Set an output file and the Source SRS (same as CRS).

e) Set the Target SRS to the desired CRS.

f) Select the desired resampling method.

g) For continuous variables, typically want to use something like bilinear or cubic spline that interpolates. If it is a categorical variable, nearest neighbor (“Near”) is generally appropriate.

h) If using a computer with a multi-core processor, check the box for “Use multithreaded warping implementation”

i) Check the box for “Load into canvas when finished” to bring the final product into the current project.
3.15 Classifying and Symbolizing Data

In this section you will learn about the different methods for classifying data and the best approach for choosing color schemes to symbolize your data. These are important concepts to grasp, as they have a direct impact on how successful your map will be in communicating your data.

Steps

A. Explore by graduated

a) Classify your data. Select **District_boundary** in the layers panel and double click to open the properties menu. Go to the style table. In the classification drop down at the top of the menu, switch the option from single symbol to graduated.

b) In the column drop down (the field you’re classifying) select (Shape area) which is the area of acreage. Change the number of classes from 5 to 4. Keep the mode as Equal Interval. Hit the classify button below the classification window.

c) Then hit OK.

d) Explore other modes of classifying the data

   a. Equal interval
b. Natural breaks

c. Quantile

d. Standard deviation etc

B. Explore by categorization

Click Ok to visualize the categorised classes

C. Explore by inverted polygons
3.16 Map publication

QGIS works well for making maps, with easily customizable symbology, and a good set of tools to develop a layout for print and publication.

a) The map will include standard map elements including a scale bar, north arrow, legend, and coordinate grid. I encourage you to explore other options and setups for this, or try making one with your own data. As with the other features of QGIS, we only have time to highlight a relatively small subset of map-making tools.

b) To get started, open the print composer by clicking on icon indicated at left. If you were to have an existing layout that you wish to access in the project, click on the icon to the right, “Composer Manager”. After clicking the icon to create a new layout, you can either designate a new name or allow the program to generate one for you.

c) A new window pops up
d) Click on the “Add New Map” icon, left click and draw a rectangle in the blank white space.

e) You can zoom in and out, and use the Move Item Content icon to move the map

f) Adding a Title. Click on Add New label icon and draw a rectangle on the map.

g) In the items properties change the label name from QGIS to the desired title of the map. Under appearance Menu click Font and click the font size and style.

h) Click the Select/Move item icon to select and move the title to the center.

i) Insert the legend by clicking on the Add New Legend icon and drawing a rectangle on the map

   a) Under item properties enable Frame to give the legend a boundary. Try adjusting the values under Spacing. Change the font size of the legend.

   b) Adding a Scale bar and north arrow. Follow the same procedure for adding the legend and add the scale bar and north arrow. You can adjust the segments of the scale bar under item properties, then segments.

   c) Add a grid to the map. Select the map. Under its item properties click on Grids, click button to insert a new grid. Enable Draw Grid and Frame. Increase the
intervals of the under Draw Grid. To label the axes enable draw coordinates.

d) Click on Composer choose Export as Image, or Export as PDF (in this case save it as an image JPEG)
e) Save the map in your working directory and set the resolution to 300 dpi
Module Three

4.1 GIS thematic data sources (Online and offline)

Module introduction

Apart from primary data collected by the participants in the field, there other institutions that collect GIS data and publish it online or offline. This data can be used to make important decisions. Or even using the same layers, the participants can update it different datasets with primary data collected from the field.

This module therefore introduces participants to existing datasets, how they can be downloaded/accessed and used/draw maps for decision making. At the end of the training, the participants shall be able to identify offline data sources and downloadable spatial datasets from online, and manipulate them for decision making.

Objectives

- To introduce the trainees to the existing GIS online and offline data domains with valuable agricultural related datasets such as FAO GAEZ, harvest choice etc
- To empower the participants on how to access and utilise existing datasets for informed decision making by the projects.

Materials

The materials for these exercises will include software, and spatial datasets

Learning outcomes

The participants shall be able to download GIS datasets and create user need maps to aid spatial decision making
4.2 Source of GIS Data

4.2.1 Introduction
Most projects begin with a search for baseline data. Some of this data exist either through online or offline domains. The online datasets are normally open sources and can be easily assessed, whereas the offline datasets are available through the mandated organizations such as NGOs, international development partners and government bodies. Indicated here below is a list spatial datasets and mandated institutions/organisations

<table>
<thead>
<tr>
<th>No</th>
<th>General purpose</th>
<th>Type</th>
<th>Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Online</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td><a href="http://www.ngdc.noaa.gov/mgg/shorelines/gshhs.html">http://www.ngdc.noaa.gov/mgg/shorelines/gshhs.html</a></td>
<td>Land and ocean boundaries</td>
<td>World</td>
</tr>
<tr>
<td>2</td>
<td><a href="http://asterweb.jpl.nasa.gov/gdem.asp">http://asterweb.jpl.nasa.gov/gdem.asp</a></td>
<td>Elevation</td>
<td>World</td>
</tr>
<tr>
<td>3</td>
<td><a href="http://www.worldclim.org/">http://www.worldclim.org/</a></td>
<td>Weather and climate</td>
<td>World</td>
</tr>
<tr>
<td>4</td>
<td><a href="http://hydrosheds.cr.usgs.gov/">http://hydrosheds.cr.usgs.gov/</a></td>
<td>Hydrology</td>
<td>World</td>
</tr>
<tr>
<td></td>
<td>Offline</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Uganda Bureau Of Statistics</td>
<td>Administration boundaries, population</td>
<td>Uganda</td>
</tr>
<tr>
<td>2</td>
<td>National Agricultural Research Organisation</td>
<td>Soils</td>
<td>Uganda</td>
</tr>
<tr>
<td>3</td>
<td>National Forestry Authority</td>
<td>Land use and cover</td>
<td>Uganda</td>
</tr>
<tr>
<td>4</td>
<td>Regional Center for Mapping of Resources for Development</td>
<td>Spatial data</td>
<td>East and southern Africa</td>
</tr>
<tr>
<td></td>
<td>Agriculture (online)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://harvestchoice.org/">http://harvestchoice.org/</a></td>
<td>Agricultural related – yields, production, travel time to markets,</td>
<td>Africa</td>
</tr>
<tr>
<td></td>
<td><a href="http://gaez.fao.org/Main.html#">http://gaez.fao.org/Main.html#</a></td>
<td>Agricultural related – consumption, suitability, yields, production e.t.c</td>
<td>World</td>
</tr>
<tr>
<td></td>
<td><a href="http://ratin.net/site/map">http://ratin.net/site/map</a></td>
<td>Storage facilities</td>
<td>EAC</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.rtb.cgiar.org/RTBMaps/">http://www.rtb.cgiar.org/RTBMaps/</a></td>
<td>Suitability, yields and production</td>
<td>Africa</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.infrastructureafrica.org/documents/tools/list/arcgis-shape-files">http://www.infrastructureafrica.org/documents/tools/list/arcgis-shape-files</a></td>
<td>Roads, boundaries, water bodies and power plants</td>
<td>Africa</td>
</tr>
</tbody>
</table>
Note: Please ensure you check the validity of datasets prior to utilisation

4.2.2 Exploring GIS Data
When you finally find some GIS data, you will want to understand whether the data is suitable for your intended study or not.

Critical aspects of a dataset should be assessed in the data documentation or Metadata for example:
- The subject of the dataset?
- What time period is represented?
- Who collected the data and why?
- What is the spatial resolution?
- What is the spatial extent?

4.2.2.1 How it works using harvest choice and FAO examples
Steps
Downloading data from Harvestchoice
a) Open your internet browser and type the following link
http://harvestchoice.org/products/data
b) Click on topic icon or regions or commodities to choose which parameter you would want to explore. Or you can get commodity specific data by clicking on commodities icon
c) For example, if you chose cassava, then click on datasets icon
d) Choose a parameter of interest e.g. cassava harvest area by double clicking on it
e) Then download datasets by clicking on the format supported by your software i.e. CSV, TIF or ASC

4.2.3 Downloading data from FAO GAEZ Portal
b) Click on access data portal on the right hand side of the page
c) Then click on register icon, then FAO
d) Once you have registered, then you login as a guest and access different datasets
e) Once files are downloaded on your computer, you can upload them in GIS software

About the dataset

![GAEZ logo]

About GAEZ Data Portal
The Land and Water Division of the Natural Resources Management and Environment Department of FAO launches the first version of the GAEZ data portal, which is part of the organization's strategic objectives to ensure that member countries have sufficient, reliable information and knowledge on sustainable management of natural resources for food and agriculture in support of policy decisions at all scales. Moreover, it will strengthen the organization's mission to improve data collection and dissemination for development and the fight against global hunger and malnutrition. The GAEZ data portal provides free and easy access to data and information. It contains many features and capabilities including:

- Browsing, querying and visualizing spatial datasets;
- Search by free text, theme, crop, input level, water supply, time period, country and region;
- Navigation, pan, zoom, identify by location spatial datasets;
- Analysis and charting tools for tabular data;
- Preparation of maps and reports for different maps and variables;
• Download spatial, tabular, and metadata option for fast extraction of data and user friendly interface.

GAEZ data portal version 3.0 was released on May 25, 2012. It includes thousands of spatial datasets and tabular information. GAEZ database will be continuously improved and updated as new datasets become available. The GAEZ data portal is designed as a dynamic system that continues to be updated. Users feedback in regards to the content of functionality of the GAEZ data portal and database is appreciated.

4.2.4 Load the downloaded dataset in QGIS

Steps
1. Add the bean yield layer in QGIS software

2. Symbolize the dataset: double click the bean yield layer, hit style menu and under band rendering select the single band pseudocolor type. Select the equal interval mode with 5 classes and click classify. Thereafter Hit OK
3. Why selection of equal interval classification mode?
   It's a data classification method that divides a set of attribute values into groups that contain an equal range of values.

4. Advantages and Disadvantages of using equal interval classification
   One advantage of using equal interval classification is that the steps to compute the intervals can easily be completed using a calculator or pencil and paper. A second advantage is that when the results of this classification are projected onto a map they are easily interpreted. Another advantage is that the legend limits contain no missing
values or gaps. This permits faster map interpretation, but might create confusion concerning the bounds of each class.

- The main disadvantage of this classification type is that it fails to consider how data are distributed along the number line.

**Practical exercise**
Explore the dataset using other classification systems
- Natural breaks
- Standard deviation
- Manual etc

4.2.5 Interpretation of thematic maps
4.2.5.1 What is a thematic map?
It’s a map of a theme or topic. Thematic maps have almost infinite variety and include most of the maps in the media showing, for example, the spread of fire ants, the status of sales taxes by State, or world population density.

4.2.5.2 Thematic maps may be quantitative or qualitative.
a) Quantitative maps portray numerical information, such as numbers of crimes in an area or crime rates.
b) Qualitative maps show non-numerical data like land use types or victim/offender characteristics, such as male or female, juvenile or adult

4.2.5.3 Kinds of measurement
Thematic maps can include four kinds of measurement data: nominal, ordinal, ratio, and interval. Nominal measurement names or labels items in unordered categories, such as race.

If a map shows homicide victims by race, it is a qualitative thematic map. Mapping by race, age group, or marital status puts labels on groups without ranking them as higher or lower or better or worse.

a) Ordinal measurement classifies incidents, victim or offender characteristics, or some other attributes (perhaps areas) according to rank.
b) Ratio scales, such as distance in inches, feet, yards, millimeters, meters, and so forth, start at zero and continue indefinitely. Zero means there is none of it and 20 means there is twice as much as 10.
c) Interval scales show values but cannot show ratios between values. Temperature is a good example. We can measure it, but we cannot say that 80 degrees is twice as warm
as 40 degrees, since the starting points of both the Fahrenheit and Celsius scales are arbitrary—that is, they are not true zeros

4.2.6 Interpretation of thematic maps

Case study: How to interpret a crop yield map?
Colorful maps are not knowledge. If these maps are to be of any real value, data generated from them must be incorporated into the decision-making, analysis, and overall planning process of the farm operation. The first step in generating and interpreting a useful yield map is deciding how the map will be presented.

4.2.6.1 Presenting Yield Maps
The selection of yield ranges and color schemes to display yield map data and accompanying legends greatly influences a map’s aesthetic appeal, quality, and utility.

The three most critical aspects for proper presentation of crop yield data include:

1) **Data aggregation: the method used to group the data into yield ranges (e.g. Natural breaks, equal interval, etc)**
   There are advantages and disadvantages to each of these methods. For example, equal count and standard deviation aggregation can exaggerate yield patterns when little or no true variation exists. Equal interval aggregation can greatly downplay variation if the yield ranges are not scaled properly, but it is far easier to interpret and compare maps with this method. Natural breaks make good intuitive sense, but they are subjective and will rarely be consistent from map to map. Most yield mapping programs allow the user to select different aggregation methods.

2) **Number of ranges: the appropriate number of data intervals to display on the yield map**
   In general, choosing too few data ranges for the yields masks real variation while choosing too many ranges results in a map that is too busy for a human observer to visually process. Use between four to ten ranges, with five being optimum. With five levels, the map will contain two levels of poor performing yields, a section that is average, and two levels that are above average yields.

3) **Color scheme: the colors that best distinguish data within the yield ranges**
   A color scheme is selected to clearly distinguish the data in the different ranges. Using a gradient in shading from light to dark in one color or using a logical sequence of colors from the visible spectrum can accomplish this. One common example is the green yellow-orange-
red shading sequence. Yield ranges go from high (greens) to medium (yellow to orange) to low (reds). Another approach is to use gradations of just two colors to illustrate the variation. Users are encouraged to test various aggregation techniques and color schemes to choose the combination that is most suitable for their intended purposes.

4.2.6.2 Yield interpretation

A yield map showing yield variability may raise more questions than it will answer and can become a source of frustration rather than a source of information. A yield map only documents the spatial distribution of crop yield, not what caused the variation. A yield map does not indicate why yields vary, whether yield potential is reached anywhere in the field, or predict yield patterns in future years. A yield map is of value only when it leads to a management decision or validates management practices. To effectively make a management decision based on a yield map, producers must be familiar with the various sources of variability that may exist in their fields and properly interpret this information. As yield maps are evaluated, sources of yield variability can be grouped into two areas: (1) variability caused by producer management practices and (2) naturally occurring variables (Table 1).

4.2.6.3 Sources of yield variability

a) Field history

Sometimes the variability in crop yield can be attributed to some historical event within the field. Look for patterns in your yield map. Patterns with straight lines tend to be man-made while irregular patterns may reflect different soil conditions, soil types, drainage problems, and pest infestations such as weeds, disease, and insects.

b) Compaction
Operating equipment on wet soil can compact the soil, destroy soil structure, and reduce crop yield. A compacted soil layer will generally have poor structure and most of the voids in the compacted layer will be eliminated. Poor drainage and root restriction can result and cause yield limiting conditions. Compacted areas may be hard to define on a yield map, but keep in mind areas of heavy traffic and equipment operation in wet conditions.

c) Water management
Many times, yield variability can be related to water management. While irrigation can be managed to reduce the weather related variability on crop yields, irrigation can also induce yield variability across the field.

d) Equipment/mechanical errors
Proper installation of reliable equipment is a must. An accurate, dependable GPS differential signal is critical for obtaining reliable data as the loss of signal results in wrong positional values relative to where the data were taken.

e) Weather
Weather is the largest factor affecting crop yield. For example, a sandy soil in a dry year has a much greater impact on crop yield than during a normal year.

f) Soil fertility
One of the first questions a producer will ask when looking at yield map patterns will be, “is there any relationship to availability of soil nutrients?” A soil test map is a valuable tool in diagnosing the reasons for yield variability. Soil pH, organic matter, cation exchange capacity (CEC), phosphorus, and potassium can be very helpful in interpreting irregular patterns in yield.

g) Soil physical properties and water management
Water holding capacity (or lack thereof) probably causes more variability in yield than any other factor. Environmental conditions impact a significantly greater amount of the crop growth potential compared to producer practices. While these factors may not be controlled, their effect may be minimized with proper management.

h) Pest concentrations
Maps or even general record information pertaining to weed, insect, and disease patterns in fields can be very valuable in yield map interpretation. Field scouting information of pest events occurring during the growing season is also an important piece of the diagnostic puzzle.

i) External variables
Factors such as windbreaks, bodies of water, roadways, buildings, fencerows, and trees can all create effects that can influence crop yield.

**Note: Decision Making:** While yield maps show variability in a field, the challenge is to develop meaningful relationships to base decisions on. Furthermore, variability in yield can be the result of several characteristics rather than one factor. In some instances, it may take five years before a meaningful management decision can be made. Some short-term decisions can be made, but longer-term decisions are tougher.
Module Four

5.1 Application of multi-criteria decision making in agricultural land use planning

Module introduction

The module introduces the participant on how to use GIS as a decision making tool in the agricultural land use planning. At the end of the module, the participants should be able to make effective decisions towards identifying project intervention sites, implementing infrastructural developments, assess the possible effects of projects on the environment among others.

Objectives

☐ To introduce the participants to multi-criteria decision making process
☐ To equip the participants with practical GIS skills to make suitability maps to facilitate decision making

Materials

The materials to be used will include but not limited to hand-outs, GPS units, videos etc.

Learning outcomes

The participants shall be able to identify project intervention sites, site infrastructural development projects among others
5.1 Introduction to Multi-criteria analysis

Multi-criteria Analysis is one of the common GIS operation used to assess and aggregate the many criteria for suitability mapping and resource allocation decisions. Multi-criteria Analysis (MCA) or Evaluation (MCE) is a technique used in decision making to analyze and compare how well different alternatives achieve different objectives and through this process identifying a preferred alternative (Therivel, 2004).

GIS-based Multi-criteria decision analysis is a process that transforms and combines geographical data (Map Criteria) and value judgments (Decision-makers preferences) to obtain relevant information for decision making (Eastmen et al. 1995, Malczewski 1999).

Site selection is one of the common tasks in GIS based multi-criteria analysis. The objective of this tutorial is to introduce the basic concepts of the multi criteria analysis in GIS.

5.2 Case study project: identification of suitable areas for establishment of oil seeds (sunflower or soya beans) in Rukwa District

The criteria for setting up sunflower farms in Lira District by the out growers is as follows:

a) The areas should be receiving moderate rainfall
b) Has moderate soil fertility to support the plantation
c) Should have a good road network
d) The input GIS datasets for the determination of suitable areas and weights are as follows

<table>
<thead>
<tr>
<th>Table 2: Data sources and weights</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>No</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
</tbody>
</table>

**Note:** the weights are dependent on project experience and expertise
5.3 Data processing

a) Open QGIS software and add the exercise layers (rainfall, roads, population, soil, topography, land use, drainage) stored on your computer OR working folder

b) From the “processing” menu click on the toolbox

c) From the “grass algorithm” in the “processing toolbox” select the “SAGA” and under it select “Vector point tools” then “Convert lines to points tool” to convert lines into points.

*The purpose is to compute surface rasters using kernel density tool*

d) Select the input line layer as “roads”

e) Set the maximum distance between the maps units as “100”

f) Set the output file name and folder and press “OK”

g) Click on the “Grass algorithms” and select the “V Kernel tool” to create the density map

h) The “V kernel tool” window will open, set the input layer names as “roads” and set the “output file name and folder” and press “OK”
i) Convert the vector layers into rasters
j) From the main menu select “Raster” select “conversion” and click on “Rasterize” (vector to raster)
k) In the map window, input file (shapefile) select “land use” select “attribute field” select “NBS 2010”
l) Set the desired attribute field
m) Set the output file name and folder
n) Click “OK”
o) Similarly rasterize the other layers (“population”, “soil” etc)

5.4 Ordered weighted averaging
p) Select the “SAGA geo algorithm” from the processing tools and click on “Raster analysis” select “ordered weighted averaging”
q) Click on the “input grids” and set the themes such as “soil”, “population” and select each year independently
r) Set the weights as per the table 1 prepared for the “soil” layer and others
s) Input the rest of the numbers from the above table
t) Set the output filename and folder
u) Press OK

v) Similarly set the weights for the remaining layers (“roads”, “landuse”, “population”, “rivers”, “slope etc)
w) On the main menu select Raster “Raster calculator”
x) In the raster calculator window, multiply the weighted layers e.g. “weighted_popn_final”* “weighted_landuse_final”* “weighted_soil_final”* “weighted_rivers_final”* “weighted_roads_final”* “weighted_slope_final”
y) Set the output file name and folder
5.5 **Weighted layer class/style definition or classification**

a) Double click the output map in the “layers panel” in the layer properties map window define the layer style by rendering to “single band pseudocolor” mode “equal interval” click on classify set to 4 classes and label the classes as per categories through (“Very high”, “high”, “moderate” and “low”)

b) Finally publish your created map from “Map Layout”

5.6 **Interpretation of suitability maps**

 ➤ Use the layer properties categorical sub definition scheme to interpret the create map
 ➤ Eg
Introduction and Advanced GIS application Agricultural Development

- Green = Very high
- Yellow = High
- Red = Low

Note:
The areas coloured with the green are highly suitable for the establishment of sunflower plantations in Lira District followed by those with the yellow unlike the red coloured areas that are not suitable.

Module Five

6.1 How to use multi-temporal Landsat satellite images to monitor agricultural land use and performance changes over time

Module introduction

The participants will be trained about satellite image acquisition, processing and how to extract information ideal to track the progress of farmers and assess the effects of changes on the environment. At the end of the module, the participants will be able to detect changes in the farmer’s agricultural land use types, performance of the farmer and determine if the changes are a threat to the environment.

Objectives

- To introduce the participants to Landsat satellite image acquisition and processing
- To equip the participants on how to extract information from satellite images

Materials

The materials to be used will include but not limited to hand-outs, GPS units, videos etc.

Learning outcomes

The participants shall be able to process and interpret satellite images.
6.2 Introduction
6.2.1 Remote Sensing

"Remote sensing is the science (and to some extent, art) of acquiring information about the Earth’s surface without actually being in contact with it. This is done by sensing and recording reflected or emitted energy and processing, analyzing, and applying that information."

In much of remote sensing, the process involves an interaction between incident radiation and the targets of interest. This is exemplified by the use of imaging systems where the following seven elements are involved. Note, however that remote sensing also involves the sensing of emitted energy and the use of non-imaging sensors.

1. **Energy Source or Illumination (A)** - the first requirement for remote sensing is to have an energy source which illuminates or provides electromagnetic energy to the target of interest.

2. **Radiation and the Atmosphere (B)** - as the energy travels from its source to the target, it will come in contact with and interact with the atmosphere it passes through. This interaction may take place a second time as the energy travels from the target to the sensor.

3. **Interaction with the Target (C)** - once the energy makes its way to the target through the atmosphere, it interacts with the target depending on the properties of both the target and the radiation.

4. **Recording of Energy by the Sensor (D)** - after the energy has been scattered by, or emitted from the target, we require a sensor (remote - not in contact with the target) to collect and record the electromagnetic radiation.
5. Transmission, Reception, and Processing (E) - the energy recorded by the sensor has to be transmitted, often in electronic form, to a receiving and processing station where the data are processed into an image (hardcopy and/or digital).

6. Interpretation and Analysis (F) - the processed image is interpreted, visually and/or digitally or electronically, to extract information about the target which was illuminated.

7. Application (G) - the final element of the remote sensing process is achieved when we apply the information we have been able to extract from the imagery about the target in order to better understand it, reveal some new information, or assist in solving a particular problem.

6.3 Application of remote sensing
The era of satellite remote sensing was open in the 1960s when cameras and electronic sensors were mounted on spacecraft. Nowadays there is a big assortment of satellite systems actively recording information about the Earth. A wide variety of imagery is available from satellites. Both active and passive sensors, operating from the microwave to the ultraviolet regions of the electromagnetic spectrum collect a large amount of information about the earth's surface every day. Each of the systems vary in terms of their spatial, spectral, radiometric and temporal resolution. Those characteristics play an important role in defining which applications the sensor is best suited for. The main benefits of satellite remote sensing are the following:

- The data are available for large areas: for example: 35 000km² for LANDSAT scene, 3 600 km² for SPOT scene
- They are available on a regular basis for all points on the globe (repetitive coverage): data may be acquired every 1-3 days (16 days in the case of LANDSAT, 1-3 days in the case of SPOT)
- They are objective: the sensor-transmission-reception system involves no human intervention
- The data collected are related to the Earth surface features
- To collect data the sensors use the wide spectrum of electromagnetic spectrum (EMS) and use several band (areas of the EMS) at once (LANDSAT TM 7, hyper-spectral: from tens to hundreds of spectral bands)
- They are in digital form and geometrically corrected images can be used to provide a base to overlay other data or to be used as part of an analysis in a GIS environment

The applications of remote sensing summarized in this unit are only representative, but not exhaustive. We focus on applications tied to the Earth surface. To show the remote sensing as data source and the benefits of remote sensing applications we emphasized some examples of touched fields.
Agricultural

Agriculture plays an important role in economies of countries. The production of food is important to everyone and producing food in a cost-effective manner is the goal of every farmer and an agricultural agency. The satellites has an ability to image individual fields, regions and counties on a frequent revisit cycle. Customers can receive field-based information including **crop identification, crop area determination and crop condition monitoring** (health and viability). Satellite data are employed in precision agriculture to manage and monitor farming practices at different levels. The data can be used to farm optimization and spatially-enable management of technical operations. The images can help determine the location and extent of crop stress and then can be used to develop and implement a spot treatment plan that optimizes the use of agricultural chemicals. The major agricultural applications of remote sensing include the following:

- vegetation
- crop type classification
- crop condition assessment (crop monitoring, damage assessment)
- crop yield estimation
- soil
- mapping of soil characteristics
- mapping of soil type
- soil erosion
- soil moisture
- mapping of soil management practices
- compliance monitoring (farming practices)

**Crop type classification**

Remote sensing technology can be used to prepare maps of crop type and delineating their extent. Traditional methods of obtaining this information are census and ground surveying. The use of satellites is advantageous as it can generate a systematic and repetitive coverage of a large area and provide information about the health of the vegetation. The data of crop is needed for agricultural agencies to prepare an inventory of what was grown in certain areas and when. This information serves to predict grain crop yield, collecting crop production statistics, facilitating crop rotation records, mapping soil productivity, identification of factors influencing crop stress, assessment of crop damage and monitoring farming activity.

**What kind of images can be used?**

There are several types of remote sensing systems used in agriculture but the most common is a passive system that senses the electromagnetic energy reflected from plants. The spectral reflection of a vegetation depend on stage type, changes in the phenology (growth), and crop
health, and thus can be measured and monitored by multi-spectral sensors. Many remote sensing sensors operate in the green, red, and near infrared regions of the EM spectrum, they measure both absorption and reflectance effects associated with vegetation. Multi-spectral variations facilitate fairly precise detection, identification and monitoring of vegetation. The observation of vegetation phenology requires multi-temporal images (data at frequent intervals throughout the growing season). Different sensors (multi-sensor) often provide complementary information, and when integrated together, can facilitate interpretation and classification of imagery. Examples include combining high resolution panchromatic imagery with coarse resolution multi-spectral imagery, or merging actively and passively sensed data (SAR imagery with multi-spectral imagery).

Some species (red color) of cultivated plant on satellite image

**Crop monitoring and damage assessment**

Remote sensing has a number of attributes that lend themselves to monitoring the health of crops. The optical (VIR) sensing advantage is that it can see the infrared, where wavelengths are highly sensitive to crop vigour as well as crop stress and crop damage. Remote sensing imagery also gives the required spatial overview of the land. Remote sensing can aid in identifying crops affected by conditions that are too dry or wet, affected by insect, weed or fungal infestations or weather related damage Images can be obtained throughout the growing season to not only detect problems, but also to monitor the success of the treatment. Detecting damage and monitoring crop health requires high-resolution, multi-spectral imagery and multi-temporal imaging capabilities. One of the most critical factors in making imagery useful to farmers is a quick turnaround time from data acquisition to distribution of crop information.
The problems inside the agricultural fields

**Soil mapping**
The disturbance of soil by land use impacts on the quality of our environment. Salinity, soil acidification and erosion are some of the problems. Remote sensing is a good method for mapping and prediction of soil degradation. Soil layers that rise to the surface during erosion have different color, tone and structure than non-eroded soils thus the eroded parts of soil can be easily identify on the images. Using multi-temporal images we can study and map dynamical features - the expansion of erosion, soil moisture.

Attempts to study land degradation processes and the necessity of degradation prediction have resulted in the creation of erosion models. The necessary information (parameters of the models; Universal Soil Loss Equation (USLE) to modeling can be often derived from satellite images. The vegetative cover is a major factor of soil erosion.
**Introduction and Advanced GIS application Agricultural Development**

Some kind of erosion in satellite image

**Forest mapping**

One of the basic applications is forest cover typing and species identification. Forest cover typing can consist of reconnaissance mapping over a large area, while species inventories are highly detailed measurements of stand contents and characteristics (tree type, height, density). Using remote sensing data we can identify and delineate various forest types, that would be difficult and time consuming using traditional ground surveys. Data is available at various scales and resolutions to satisfy local or regional demands. Requirements for reconnaissance mapping depend on the scale of study. For mapping differences in forest cover (canopy texture, leaf density,) are needed:

- multi-spectral images, a very high resolution data is required to get detailed species identification
- multi-temporal images datasets contribute phenology information of seasonal changes of different species
- stereo photos help in the delineation and assessment of density, tree height and species
- hyper-spectral imagery can be used to generate signatures of vegetation species and certain stresses (e.g. infestations) on trees. Hyper-spectral data offers a unique view of the forest cover, available only through remote sensing technology
- RADAR is more useful for applications in the humid tropics because its all weather imaging capability is valuable for monitoring forest
LiDAR data allows the 3-dimensional structure of the forest. The multiple return systems are capable of detecting the elevation of land and objects on it. The LIDAR data help estimate a tree height, a crown area and number of trees per unit area.

**Clear cut mapping and deforestation**
One of an important global problem is deforestation. There are many implications of it: in industrialized parts of world, pollution (acid rain, soot and chemicals from factory smoke plumes) has damaged a large percentage of forested land, in tropical countries, valuable rainforest is being destroyed in an effort to clear potentially valuable agricultural and pasture land. The loss of forests increases soil erosion, river siltation and deposition, affecting the environment.


**Land cover**
*Land cover mapping* is one of the most important and typical applications of remote sensing data. Land cover corresponds to the physical condition of the ground surface, for example, forest, grassland, concrete pavement etc., while land use reflects human activities such as the use of the land, for example, industrial zones, residential zones, agricultural fields etc Initially the land cover classification system should be established, which is usually defined as levels and classes. The level and class should be designed in consideration of the purpose of use (national, regional or local), the spatial and spectral resolution of the remote sensing data, user’s request and so on.
Land cover change detection is necessary for updating land cover maps and the management of natural resources. The change is usually detected by comparison between two multi-date images, or sometimes between an old map and an updated remote sensing image.

- **seasonal change**: agricultural lands and deciduous forests change seasonally
- **annual change**: land cover or land use changes, which are real changes, for example deforested areas or newly built towns.

### 6.4 Landsat satellite image acquisition

Landsat represents the world’s longest continuously acquired collection of space-based moderate-resolution land remote sensing data. Four decades of imagery provides a unique resource for those who work in agriculture, geology, forestry, regional planning, education, mapping, and global change research. Landsat images are also invaluable for emergency response and disaster relief.

As a joint initiative between the U.S. Geological Survey (USGS) and NASA, the Landsat Project and the data it collects support government, commercial, industrial, civilian, military, and educational communities throughout the United States and worldwide.

On May 30, 2013, data from the Landsat 8 satellite (launched as the Landsat Data Continuity Mission - LDCM- on February 11, 2013) became available. As with previous partnerships, this mission continues the acquisition of high-quality data that meet both NASA and USGS scientific and operational requirements for observing land use and land change.

The Landsat project is an integral part of the Remote Sensing Missions component of the USGS Land Remote Sensing (LRS) Program.

### 6.5 What are the band designations for the Landsat satellites?

**Landsat Multispectral Scanner (MSS)** images consist of four spectral bands with 60 meter spatial resolution. Approximate scene size is 170 km north-south by 185 km east-west (106 mi by 115 mi). Specific band designations differ from Landsat 1-3 to Landsat 4-5.

<table>
<thead>
<tr>
<th>Multispectral Scanner (MSS)</th>
<th>Landsat 1-3</th>
<th>Landsat 4-5</th>
<th>Wavelength (micrometers)</th>
<th>Resolution (meters)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Band 4</td>
<td>Band 1</td>
<td>0.5-0.6</td>
<td>60*</td>
<td></td>
</tr>
<tr>
<td>Band 5</td>
<td>Band 2</td>
<td>0.6-0.7</td>
<td>60*</td>
<td></td>
</tr>
</tbody>
</table>
* Original MSS pixel size was 79 x 57 meters; production systems now resample the data to 60 meters.

**Landsat Thematic Mapper (TM)** images consist of seven spectral bands with a spatial resolution of 30 meters for Bands 1 to 5 and 7. Spatial resolution for Band 6 (thermal infrared) is 120 meters, but is resampled to 30-meter pixels. Approximate scene size is 170 km north-south by 183 km east-west (106 mi by 114 mi).

<table>
<thead>
<tr>
<th>Thematic Mapper (TM)</th>
<th>Landsat 4-5</th>
<th>Wavelength (micrometers)</th>
<th>Resolution (meters)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Band 1</td>
<td>0.45-0.52</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Band 2</td>
<td>0.52-0.60</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Band 3</td>
<td>0.63-0.69</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Band 4</td>
<td>0.76-0.90</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Band 5</td>
<td>1.55-1.75</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Band 6</td>
<td>10.40-12.50</td>
<td>120* (30)</td>
<td></td>
</tr>
<tr>
<td>Band 7</td>
<td>2.08-2.35</td>
<td>30</td>
<td></td>
</tr>
</tbody>
</table>

* TM Band 6 was acquired at 120-meter resolution, but products are resampled to 30-meter pixels.

**Landsat Enhanced Thematic Mapper Plus (ETM+)** images consist of eight spectral bands with a spatial resolution of 30 meters for Bands 1 to 7. The resolution for Band 8 (panchromatic) is 15 meters. All bands can collect one of two gain settings (high or low) for increased radiometric sensitivity and dynamic range, while Band 6 collects both high and low gain for all scenes. Approximate scene size is 170 km north-south by 183 km east-west (106 mi by 114 mi).

<table>
<thead>
<tr>
<th>Enhanced Thematic Mapper</th>
<th>Landsat 7</th>
<th>Wavelength (micrometers)</th>
<th>Resolution (meters)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Band 1</td>
<td>0.45-0.52</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Plus (ETM+)</td>
<td>Band 2</td>
<td>0.52-0.60</td>
<td>30</td>
</tr>
<tr>
<td>------------</td>
<td>---------</td>
<td>-----------</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td>Band 3</td>
<td>0.63-0.69</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 4</td>
<td>0.77-0.90</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 5</td>
<td>1.55-1.75</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 6</td>
<td>10.40-12.50</td>
<td>60 * (30)</td>
</tr>
<tr>
<td></td>
<td>Band 7</td>
<td>2.09-2.35</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 8</td>
<td>0.52-0.90</td>
<td>15</td>
</tr>
</tbody>
</table>

* ETM+ Band 6 is acquired at 60-meter resolution, but products are resampled to 30-meter pixels.

**Landsat 8 Operational Land Imager (OLI) and Thermal Infrared Sensor (TIRS)** images consist of nine spectral bands with a spatial resolution of 30 meters for Bands 1 to 7 and 9. New band 1 (ultra-blue) is useful for coastal and aerosol studies. New band 9 is useful for cirrus cloud detection. The resolution for Band 8 (panchromatic) is 15 meters. Thermal bands 10 and 11 are useful in providing more accurate surface temperatures and are collected at 100 meters. Approximate scene size is 170 km north-south by 183 km east-west (106 mi by 114 mi).

<table>
<thead>
<tr>
<th>Landsat 8 Operational Land Imager (OLI) and Thermal Infrared Sensor (TIRS)</th>
<th>Bands</th>
<th>Wavelength (micrometers)</th>
<th>Resolution (meters)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Band 1 - Coastal aerosol</td>
<td>0.43 - 0.45</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 2 - Blue</td>
<td>0.45 - 0.51</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 3 - Green</td>
<td>0.53 - 0.59</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 4 - Red</td>
<td>0.64 - 0.67</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 5 - Near Infrared (NIR)</td>
<td>0.85 - 0.88</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 6 - SWIR 1</td>
<td>1.57 - 1.65</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Band 7 - SWIR 2</td>
<td>2.11 - 2.29</td>
<td>30</td>
</tr>
</tbody>
</table>
Introduction and Advanced GIS application Agricultural Development

<table>
<thead>
<tr>
<th>Band 8 - Panchromatic</th>
<th>0.50 - 0.68</th>
<th>15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Band 9 - Cirrus</td>
<td>1.36 - 1.38</td>
<td>30</td>
</tr>
<tr>
<td>Band 10 - Thermal Infrared (TIRS) 1</td>
<td>10.60 - 11.19</td>
<td>100 * (30)</td>
</tr>
<tr>
<td>Band 11 - Thermal Infrared (TIRS) 2</td>
<td>11.50 - 12.51</td>
<td>100 * (30)</td>
</tr>
</tbody>
</table>

* TIRS bands are acquired at 100 meter resolution, but are resampled to 30 meter in delivered data product.

6.6 Where to download the Landsat imagery?

- **USGS GloVis: The Global Visualization Viewer:** On GloVis (http://glovis.usgs.gov/), you can search for data by clicking on an interactive map or by entering the geographic coordinates (latitude and longitude) of the site you are searching for. After clicking on the map or entering coordinates, the GloVis view window will appear on your screen showing you nine adjacent Landsat 7 browse images. This allows you to visually locate the best Landsat image for your purposes. Use the menu at the top of the view window to view data from different sensors, to change the browse image resolution, or to view map layers. You can use the “Add” and “Order” buttons at the lower left corner of the viewer to order data, or if a read “Downloadable” label appears on the image, you can download the data immediately. All data is now orthorectified and in GeoTIFF format.

- **USGS Earth Explorer:** The USGS Earth Explorer website (http://earthexplorer.usgs.gov/) allows you to custom tailor your search parameters for Landsat data. After entering the website (you must create a login), you can either search for data by selecting a region on a map, by entering coordinates, or by entering a place name. Additionally, you also have the option to choose your data set (e.g. “Landsat 4-5 TM”, “Landsat 7 ETM+”, “Landsat Orthorectified ETM+”) and then select parameters such as acceptable cloud-cover percentages and the range of desired acquisition dates. + Earth Observatory’s Quick Guide to Earth Explorer for Landsat 8

6.7 Types of satellite image classification

Digital image classification techniques group pixels to represent land use/cover features. Land cover could be forested, urban, agricultural and other types of features. There are three main image classification techniques.
Image Classification Techniques in Remote Sensing:

1) Unsupervised image classification
2) Supervised image classification
3) Object-based image analysis

Pixels are the smallest unit represented in an image. Image classification uses the reflectance statistics for individual pixels. Unsupervised and supervised image classification techniques are the two most common approaches. However, object-based classification has been breaking more ground as of late.

6.8 What is the difference between supervised and unsupervised classification?

a) Unsupervised Classification

Pixels are grouped based on the reflectance properties of pixels. These groupings are called “clusters”. The user identifies the number of clusters to generate and which bands to use. With this information, the image classification software generates clusters. There are different image clustering algorithms such as K-means and ISODATA.

The user manually identifies each cluster with land cover classes. It’s often the case that multiple clusters represent a single land cover class. The user merges clusters into a land cover type. The unsupervised classification image classification technique is commonly used when no sample sites exist.

b) Supervised Classification

The user selects representative samples for each land cover class in the digital image. These sample land cover classes are called “training sites”. The image classification software uses the training sites to identify the land cover classes in the entire image.

The classification of land cover is based on the spectral signature defined in the training set. The digital image classification software determines each class on what it resembles most in the training set. The common supervised classification algorithms are maximum likelihood and minimum-distance classification.
c) **Object-Based (or Object-Oriented) Image Analysis Classification**

Object-based Classification

Traditional pixel-based processing generates square classified pixels. Object-based image classification is very different in that it generates objects of different shape and scale. This process is called multi-resolution segmentation.
Multi-resolution segmentation produces homogenous image objects by grouping pixels. Objects are generated. These objects are more meaningful than the traditional pixel-based segmentation because they can be classified based on texture, context and geometry.

Object-based image analysis supports the use of multiple bands for multi-resolution segmentation and classification. For example, infrared, elevation or existing shape files can simultaneously be used to classify image objects. Multiple layers can have context with each other. This context comes in the form of neighborhood relationships, proximity and distance between layers.

Nearest neighbor (NN) classification is similar to supervised classification. After multi-resolution segmentation, the user identifies sample sites for each land cover class. The statistics to classify image objects are defined. The object based image analysis software then classifies objects based on their resemblance to the training sites and the statistics defined.

6.9 Landsat satellite image classification in QGIS using Semi-Automatic Classification Plugin

The Semi-Automatic Classification Plugin (SCP) is a free open source plugin for QGIS that allows for the semi-automatic classification (also supervised classification) of remote sensing images. Also, it provides several tools for the pre-processing of images, the post processing of classifications, and the raster calculation.

SCP allows for the rapid creation of ROIs (training areas), through region growing algorithm, which are stored in a shapefile. The scatter plot or ROIs is available. Spectral signatures of training areas are calculated automatically, and can be displayed in a spectral signature plot along with the values thereof. Spectral distances among signatures (e.g. Jeffries Matusita distance, or spectral angle) can be calculated for assessing spectral separability. Spectral signatures can be exported and imported from external sources. Also, a tool allows for the
selection and download of spectral signatures from the USGS Spectral Library.

SCP implements a tool for searching and downloading Landsat and Sentinel images. The following tools are available for the preprocessing of images: automatic Landsat conversion to surface reflectance, clipping multiple rasters, and splitting multi-band rasters. The classification algorithms available are: Minimum Distance, Maximum Likelihood, Spectral Angle Mapping. SCP allows for interactive preview of classification. The post processing tools include: accuracy assessment, land cover change, classification report, classification to vector, reclassification of raster values.

Steps
1) **STEP 1: Activate the SCP plugin.**
2) Go to Plugins menu > Manage Plugins and enable the Semi-Automatic Classification.
3) Click close and have a look at the new appearance of QGIS interface. The SCP toolbar is added to QGIS automatically. Else right click on the toolbars and enable the SCP toolbar.
4) 

5) **STEP 2: Load the data.** Click on the Add Raster icon and add Landsat images

![Image of Raster Adder Icon](image1)

6) **STEP 3: Clip the study area.**

7) Click on the Pre-processing button in the SCP menu.

![Image of Pre-processing Plugin](image2)

8) Under Raster list, click the button Refresh list and the Landsat bands loaded in QGIS will be listed in the table.
9) Click the button **Select all** in order to clip all the images. Under Clip coordinates there are UL and LR and Use shapefile for clipping. We are going to use the UL and LR to clip the rasters. Under UL

10) Click a button and click on one edge of your clip area. In the Clip coordinates menu, the X and Y coordinates of the UL have been added.

11) Right click on the other edge of your clip area’s diagonal. You can see that a square or a rectangle is drawn.

12) Click on clip and select the working directory. When clipping is done, the rasters are added automatically. Remove other rasters and remain with the clipped rasters.
13) **STEP 4: Create a band Set (Composite Band)**
14) Now we need to define the Band set which is the input image for SCP. Open the tab and click the Pre-Processing button in the SCP menu. Click the button **Select All**, then Add rasters to set (order the band names in ascending order, from top to bottom, using the arrow buttons). Finally, select Landsat 8 OLI from the combo box Quick wavelength settings, in order to set automatically the center wavelength of each band (this is required for the spectral signature calculation).

15) You can notice that the item << band set >> is selected as Input image in the Toolbar.
16) Then click Create Raster of band set (stack band) and the band will be created

17) Step 5: Creating the Training shapefile and signature List File

18) Set the input image in the SCP. First In the SCP Toolbar click the button \[\text{Refresh}\] for refreshing the list Input image. In the list Input image select the composite.

19) In the list RGB select the item 4-3-2 for displaying a Color Composite of Near-Infrared, Red, and Green. The image in QGIS will be updated accordingly.

20) In order to collect Training Areas (ROIs) and calculate the Spectral Signature thereof, we need to create the Training shapefile and Signature list file in SCP.

21) In the ROI Creation dock click the button New shp and define a name (e.g. ROI.shp) in order to create the Training shapefile that will store ROI polygons. The shapefile is created and added to QGIS. The name of the Training shapefile is displayed in Training shapefile.

22) Also, click the button Save in the Classification dock and define a name (e.g. SIG.xml) in order to create the Signature list file that will store spectral signatures. The path of the Signature list file is displayed in Signature list file.

23) Step 6: Creating the ROI

24) We are going to create ROIs defining the Classes and Macroclasses. The Macroclass ID codes are illustrated in the following table (of course, one can define different codes and classes according to the needs).

<table>
<thead>
<tr>
<th>Macroclass name</th>
<th>Macroclass ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water</td>
<td>1</td>
</tr>
<tr>
<td>Built-up</td>
<td>2</td>
</tr>
<tr>
<td>Vegetation</td>
<td>3</td>
</tr>
<tr>
<td>Bare soil</td>
<td>4</td>
</tr>
</tbody>
</table>

25) ROIs can be created by manually drawing a polygon \[\text{polygon}\] or with an automatic region growing algorithm using \[\text{+}\].

26) Zoom in the map over the dark area (it is a lake) in the lower right region of the image. In order to create manually a ROI inside the dark area, click the button \[\text{ROI creation}\] in the ROI creation else click \[\text{ROI Properties}\], under ROI Properties set the Range Radius to 200 and click in the center of the lake. An orange semi-transparent polygon is displayed over the image, which is a temporary polygon (i.e. it is not a shapefile).
27) It is required to define the Classes and Macroclasses. In the ROI Signature definition set MC ID = 1 and MC Info = “Water”; also set C ID = 1 and C Info = “Lake”.

28) In order to save the polygon in the Training shapefile click the button Save ROI. After a few seconds, the ROI is listed in the ROI list. Also, the spectral signature is calculated and listed in Signature list (because Add sig. list was checked in Classes and Macroclasses).
29) Now we have created the first ROI. Create the ROI for subsistence, Bush land and wetlands.

30) **TIP**: The region growing algorithm can create more homogeneous spectral signatures than ROI created manually, which is good for the use of the algorithm Spectral Angel Mapping and Maximum Likelihood. The manual creation of ROIs can be useful in order to account for the spectral variability of a class, especially when using the algorithm Maximum Likelihood.

31) **Step 7: Create a classification preview**

32) It is useful to create a Classification preview in order to assess the results before the final classification.

33) Set the colors of the spectral signatures, which will represent classes in the classification output: in the Signature list double click the color in the column Color and choose a representative color of each class.
34) In the Classification algorithm select the classification algorithm **Maximum likelihood** that we are going to use in this tutorial. In Classification preview set Size = 2000, click the button + and then left click the image in the map in order to create a classification preview. The result is a square in the map which represents the classification output.
Module Six

6.1 Prediction of risks faced by the farmers using GIS

Module introduction

This module will empower the participants with knowledge and skills to assess the vulnerability of farmers to climate hazards (e.g. drought, floods, pests and diseases etc) and how their vulnerability can guide the development of appropriate insurance products and verifying payment claims. Also assessing farmers’ operation capacity (level) i.e. production level in terms of farm size, yields, use of inputs such as fertilisers, access to extension services and distance or travel time to markets e.t.c can guide financial institutions on the loan size a farmer can handle. At the end of the module, the participants will be able to assess the farmer’s potential to access credit and insurance products and develop vulnerability maps.

Objectives

- To train the participants on how to assess the risks faced by farmers and how their vulnerability can guide the development of appropriate insurance products
- To train the participants on how to assess the farmers’ operation capacity to guide financial institutions

Materials

The materials to be used will include but not limited to hand-outs, GPS units, videos etc

Learning outcomes

The participants shall be able to use GIS to determine the risks faced by the farmers
6.2 Introduction

6.2.1 Mapping Risk
All you hear today is that insurance companies can save you 15% or more on insurance. They can do this because they can better assess risk.

So how do insurance companies use location intelligence?
Insurers better understand where flood restoration, earthquake damage and hurricane cleanup occurs… All are location-based phenomena.

It’s all about predicting risk in the insurance industry. And insurance companies better manage risk with Geographic Information Systems.

Insurance technology like GIS brings to the fingertips of underwriters much quicker, in real-time data to improve decision making at a quicker pace.

6.2.2 But what are these real-time decisions?

a) Risk assessment uses geographic information to predict risk. Higher risk means higher premiums. Lower premiums are for areas with less risk. Insurance companies divide areas into territories. These territories can be assessed piece-by-piece with risk

b) Claims management involves processing claims with respect to compensation, restoration and repayment in response to loss or damage. GIS assists understanding where risk happens and where customer locations are.

c) Insurance underwriting evaluates risk and exposure for potential clients. The underwriting process decides the amount of coverage, cost and even whether or not the client should be insured at all. GIS enables targeted sales and marketing knowing that underwriters made the right decision. Who are insured? Where is error proximity to hazard? GIS insurance technology lets underwriters examine phenomena quicker and at a more granular level.

d) Insurance fraud is a fraudulent claim usually for personal gain. Geospatial analytics can be used from the start with address misrepresentation. When the public knows another address gets a higher premium, it's misrepresentation to get a lower premium by falsifying an address. On the claims side, GIS insurance technology can look at suspicious behavior with statistics. When you add location to fraud investigation techniques, it's a supplementary analysis to analyze opportunistic behavior for insurance claims.

6.2.3 Examples
a) **One:** Charging higher insurance premiums in flood-prone areas using Google Earth images

**About Google Earth**
Google Earth is a free program from Google that allows you to "fly" over a virtual globe and view the Earth through high-resolution graphics and satellite images. It is greatly superior to static maps and satellite images. The images are detailed enough that in most populated areas you can clearly see your house, objects in your yard, and recognize your car parked along the street. A digital elevation model within Google Earth allows you to view the landscape in 3D.

**Recent Images, Updated Regularly.**

Most of the images in Google Earth were acquired within the past three years, and Google is continuously updating the image set for different parts of the Earth. Large cities generally have more recent and higher resolution images than sparsely inhabited areas. Google has the ability to rapidly integrate new images into the program for areas that have been hit by a natural disaster to assist in recovery and relief efforts.

Gogonyo Sub County in Pallisa district is normally submerged in the eventuality of flash floods
The reality is:

1) Insurance companies are getting really good at determining risk because they hold a lot of risk.

2) One insurance company may divide Pallisa district into separate territories. Each territory assesses how much risk and how much of a premium to charge.

3) This is why insurance companies can offer such low premiums. GIS insurance technology obtains more granular level of detail with a more holistic view for insurance risk assessment.

b) **Two: Doing the detective work for fraudulent crop insurance claims**

As climate becomes less predictable and more destructive (such as droughts and floods), farmers have to adapt to this new reality.

In these cases, crop insurance can help farmers supplement their income when their fields don’t get seeded. Insurance companies are teaming up to up to fight crop insurance fraud.
A set of Landsat satellite images can be downloaded and used to measure vegetation growth using Landsat red, infrared channels in combination using a Normalised Difference Vegetation Index (NDVI) to detect crop production.

**Note:** It is critical for the insurance company to use the dataset and set the threshold values after a careful assessment of the previous years

**Steps**

1) **Online access to Vegetation Health Index**
This dataset can facilitate monthly monitoring of crop production which can fight crop production fraud.


2) **Vegetation Health Index**
The Vegetation Health Index (VHI) is a composite index and the elementary indicator used to compute the ASI. It combines both the VCI and the Temperature Condition Index (TCI). The TCI is calculated using a similar equation to the VCI, but relates the current temperature to the long-term maximum, as it is assumed that higher temperatures tend to cause a deterioration in vegetation conditions.

A decrease in the VHI following, for example, a decline in the VCI (relatively poor green vegetation) and an increasing TCI (warmer temperatures) would signify stressed vegetation conditions, and over a longer period would be indicative of drought. The VHI components (VCI and TCI) are given equal weights when computing the index. The VHI images are computed for the two main seasons and in three modalities: dekadal, monthly and annual.
3) **Agricultural Stress Index**

The seasonal indicators are designed to allow easy identification of areas of cropped land with a high likelihood of water stress (drought). The indices are based on remote sensing data of vegetation and land surface temperature combined with information on agricultural cropping cycles derived from historical data, and a global crop mask. The final maps highlight anomalous vegetation growth, and potential drought, in crop zones during the growing season.
The satellite data used in the calculation of the mean VHI and the ASI is the 10-day (dekadal) vegetation data from the METOP-AVHRR sensor at 1 km resolution (2007 and after). Data at 1 km resolution for the period 1984-2006 was derived from the NOAA-AVHRR dataset at 16 km resolution. The crop mask is a modified version of an EC-JRC data set that compiles several different sources of land cover data, including GlobCover V2.2, Corine-2000, AfriCover, SADC data set and USGS Cropland Use Intensity Data Set.


- Even after the fact a claim is processed, you can verify claims using free Landsat-8 data available to the public online.
- Crop insurance companies gain the right tools to verify seeded crops and catch fraud.
"The application of GIS is limited only by the imagination of those who use it". Jack Dangermond, Esri

References
